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1 Ruskin software

Ruskin is the only tool you need to manage all your RBR instruments and measurement data. It is available for Mac and
Windows PC.

Use the Ruskin software to do the following:

« Configure, schedule, and enable multiple instruments
« Estimate your deployment times

« Download your data after logging

« View your datasets graphically

» Export your data in various formats

« Analyse your data

« Change the calibration coefficients for your instrument
« Perform user calibration

« ContactRBR

RSK files generated by Ruskin contain contain raw measurement data, firmware and software versions, dates and
times, sampling settings, power settings, measured and derived parameters, errors and events, other diagnostic
information. They can be read directly in Matlab, or exported to Excel, OceanDataView®, or text files.

Find Ruskin software for Mac and PC on the USB stick included with your instrument, or visit the RBR website to
download the latest version.

The most recent software updates, release notes, Ruskin user guides, instrument guides, and quick start guides are
available from the Help menu in Ruskin.

@ Ruskin File Instruments Factory Developer Diagnostic Help

oce® [sea Ruskin v2.17.2.202203042007
Eo 3 Navigatc; Y =08 | £ Release notes
i Instruments Sensdrs 2
1 Compact Instruments >
dinMLM Comment on Ruskin... : ) .
£ Datasets Se > | Quick Start Guide
;:‘;‘;‘0” Enter Feature Code... RBRlegato® glider/AUY CTD > Command reference
RSK processor... Legacy Instruments o RBReoncerta® C.T.Djuv QSG

2
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2 Ruskin interface

Ruskin software has a user-friendly interface which consists of a Toolbar and three main windows: Navigator,
Properties, and Plot.

Toolbar
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In the Navigator window, you will find the list of instruments connected to Ruskin, as well as MLM (if applicable) and
datasets.

When an instrument on the list is selected, the Properties window displays four tabs with information related to this
instrument: Configuration, Information, Calibration, and Parameters. Use these tabs to configure your deployment,

check the calibration certificates, and verify your parameters.
The data plot will appear in the Plot window below if the realtime option is available and selected for this instrument, or
if you click the Fetch button ¥ on the far right of the toolbar.

Click-and-drag window tabs to rearrange the windows within Ruskin, or move a window outside of Ruskin. Hover over a

side of a window, and when the cursor becomes a two-way arrow , move it to adjust the window size.

RBR#0006106revK



Click the Close button in the top right corner to close a window. For example, you can close the Navigator
window to have a better view of the Properties. The closed window icon will appear on the sidebar (in this case,

=

Navigator ). Click the Multiple windows button above the closed window icon to re-open it.

= [ rercancertot 200851 52 -
onfiguration . Infoemation Callbration | Parsmeters
Sehedun samgling aprions

n
a]

Status: Stopped, user requast Moge: Confimevs @ Realtime: ~ Sorial @ Fomat: Standard resolution a
1 24z s

Clack: 022-07-07 0981390400 ute Local P e Seial | 115200 @ wose  RS232 8

St 2022-06-17 ¥ 3IOPM T T New Storage:  Desiop @ wi-si o

Battery,  Lithlum thiony| chioside e
Extemat: | Other { unknown a
Gatog
Extonded battery endoap
» Somple sawer getalls Mode;  Mone
iemory used <1% Downlga...
Enabla Revert sattings Uss auta-deploy satings

& raplacd price 12 deplayme

i RBRconcerto’ 200687 7

7| | Capturing to fUsersfichapman/209681_2022070
Sample -~ (17 captured)

Tima

" ke et unit
1 -0.0004000 mrSfem
2 22.0836000  *C
3 10.0B00000  dbar
a

Double-click a window tab to maximise that window, and double-click the tab again to return it to the original size.

|

Alternatively, use the Single window and Multiple windows buttons.

() Whenyou restart Ruskin, it returns to its original layout.
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The Toolbar at the top left above the Navigator window has four dropdown menus. If you are using a Mac computer, it
appears as follows:

@ Ruskin File Instruments Help

On a Windows PC, the Toolbar looks slightly differently:

File Instruments Options  Help

The rest of the interface is the same between the two systems.

2.1 Ruskin /Options

On your Mac, go to the Ruskin dropdown menu to access information on current software version, set up your
preferences, or quit Ruskin. Note that the rest of the options on this dropdown menu depend on your operating system
and are external to Ruskin.

@ Ruskin File Instruments Help

o | T
A5 Na Preferences...

" i

O Services » 1
g Hide Ruskin

Hide Others

Show All

Quit Ruskin

On your Windows PC, use the Options dropdown menu to set up your preferences.

File Instruments Opticns  Help
-@Nayigatgr Preferences... = B

RBR#0006106revK 8



2.2 File

Go to the File dropdown menu to open or close a dataset, export your data, and see the list of available datasets. The
Datasets menu in the Navigator windows duplicates some of these options for convenience.

® Ruskin File Instruments Help

oo

I-ﬁ-Navigatar\ﬁl Close dataset = O

bod i Instrumen Export >

CRBRconcel
i MLM 1: 209681_20220414_1600.rsk

3 Datasets

2.3 Instruments

Go to the Instruments dropdown menu to simulate an instrument, update your firmware, set up automatic tasks, or
take advantage of the utilities.

A The Utilities option is a support tool. Do not use unless instructed by RBR.

@ Ruskin File Instruments Help

oo

n T i s ¥ : 4 = E "
45 Navigator i acaided s
“~——  Update instrument firmware...

v i Instruments

CRBRconcerto? Automatic tasks >
wn MLM

v & Datasets Utllities >
s 209681... 1600 -

The Instruments menu in the Navigator windows duplicates some of these options for convenience.

2.4 Help

Go to the Help dropdown menu to access the latest release notes and technical documentation, provide your feedback,
check for updates, or to add a beta feature. On Mac, you can also use the Search option.

& Ruskin File Instruments Hal? J

eoe |
re—
© @ Instruments Documentation >
ORBReconcerto? 209681 - o
Comment on Ruskin...
wamMLM tor
£ Datasets

Check for updates....
Enter Feature Code...

RBR#0006106revK 9



3 Installation

Ruskin is the only piece of software you need to operate your RBR instruments. RBR releases Ruskin software versions
compatible with Mac and PC (Ruskin Desktop), as well as with iOS® and Android™ (Ruskin Mobile).

Install the Ruskin Mobile app on your mobile device by going to the Apple App store or Google Play.

Follow the steps below to install Ruskin Desktop on your computer.

3.1 Install Ruskin on a PC

You can install Ruskin on a PC that runs the Windows 7, 8, 8.1, or 10 operating system.

The minimum requirements for Ruskin are:

+ 0S=Windows 7

+ Processor speed = 1.4GHz

+ RAM required = 2GB

« Display resolution = 1024x768 recommended
« HDD space for installation = 500MB

The instruments use a USB interface to communicate with Ruskin.

Steps
1. Connect the USB stick included with your instrument to a port on your computer.
Navigate to the "Ruskin Installation" folder and doubleclick on the file RuskinSetup. exe.
Follow the installation wizard. By default, Ruskin will be installed to C: \RBR.
At the end of the installation, you will see a prompt asking, "Would you like to install the logger driver at this
time?"
5. Click Yes to install the drivers.

s

A You may need to run the setup application as an administrator to install the driver correctly.

A shortcut to Ruskin will appear on the desktop and in a Start menu folder.

() The most recent version of Ruskin software can be found at https://rbr-global.com/products/software.
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3.2 Install Ruskin on a Mac

You can install Ruskin on a Mac running OS X 10.12 (Sierra) or later.

Steps

1. Connect the USB stick included with your instrument to a port on your adaptor.

2. Navigate to the "OSX" folder and double-click on the file Ruskin.dmg.

3. When the disk image window opens, drag the Ruskin icon into the Applications directory and wait for the copy
to complete. An application named "Ruskin" will appear in the Applications folder.

A Always use the default Applications folder as the working directory.

4. Right-click on the icon, and select Open.
5. The dialogue box shown below will prompt you to authorise the opening of Ruskin.

“Ruskin” is from an unidentified developer.
- p Are you sure you want to open it?

Cpening “Ruskin® will always allow it to run on this
Mac.

b

Goegle Chrome downloaded this file today at 3143 P
from updates.rbr-global.com

& You may need to navigate to System Preferences > Security & privacy to allow the apps downloaded
from “Anywhere” to complete the installation.

6. Dragthe Ruskin.app application to the Dock.

RBR#0006106revK 11



3.3 Update Ruskin

To take advantage of new features and bug fixes, ensure that you are using the most recent version of Ruskin.

« Find the most recent version of Ruskin at https://rbr-global.com/products/software.

+ Receive an automatic notification about a new release when you start the application.

+ Check from within Ruskin by navigating to Help > Check for updates.

+ Send an email to support@rbr-global.com, subject: "Ruskin update request", and ask us to add you to the
mailing list. You will receive an email as soon as the new version is released.

If you have a broadband connection, simply follow the installation instructions on your computer. Otherwise, request a
USB stick from RBR.

& tisnot necessary to uninstall the older version of Ruskin before installing the newer version. The installation
program deletes the older files before installing the newer ones. It does not delete any Ruskin data files or log
files.

3.4 Uninstall Ruskin

Uninstall Ruskin only if you no longer need to manage RBR instruments from your computer.

It is not necessary to uninstall the older version of Ruskin before installing the newer version. The installation program
deletes the older files before installing the newer ones. For more information, see Update Ruskin.

& Removing Ruskin will not delete your data files or your diagnostic logs.

Uninstall Ruskin on a PC, Windows 7, 8, 8.1, or 10

1. Goto Start > Control Panel > Programs.

Under Programs and Features, click Uninstall a program.
Find Ruskin on the list.

Click Ruskin to highlight it.

Click Uninstall.

aprwN

Uninstall Ruskin on a Mac, OS X 10.12 or later

Move the Ruskin application from Applications to the Trash.

RBR#0006106revK 12
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4 Support

You can get in touch with RBR in several different ways:

« Send us an email. For technical questions, use support@rbr-global.com, and for general inquiries, info@rbr-
global.com.

« Contact us via the website at https://rbr-global.com/about-rbr/contact-rbr.
« Callusat+1(613) 599-8900.

« Send us a bug report from within Ruskin itself.

& When experiencing an issue, look for a solution under the Help menu before contacting RBR.

The Help menu on Ruskin offers access to technical documentation, feedback forms, and software updates. On Mac,
you can also search for Ruskin menu options.

@ Ruskin File Instruments Help

eoe® |
4 Novigstor Coessenoes |
v # fnatrimaats. Documentation > b
OsimRBRsolo® 904963 Comment on Ruskin =
#RBRconcerto® 208681
s MLM Check for updates.... I
5 Datasets

Feature codes...

‘ ‘ wwer  evee-ug-wo |

Start: 2022-05-17 ~
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4.1 Search on Mac

If using a Mac computer, you can take advantage of the Search option.
In the Search field under Help, type in a word, part of the word, or even a single letter to open a list of matching items.

The top half of the list pertains to Ruskin, while the bottom part comes from the Mac environment.

@ Ruskin File |Instruments Help

[ BN a (>}
45+ Navigator
i Instrument;- | i AecutRuskn |
= MLM = Show All 4
£ Datasets [=] Export > Annotations I

= 1: AUTD_209681_20220613_1311.rsk
I=| Simulate an instrument...

[=| Automatic tasks

I=| Automatic tasks > Auto-download

I=| Automatic tasks > Auto-stop

= Automatic tasks > Auto-deploy

=l Automatic tasks > View auto-deploy settings...

D]

| Add a network service on Mac

¢

-

]
o,

Save a document in PostScript format on Mac

%
R

(&)

Add a password hint on Mac

_‘
2

Save a document as a PDF on Mac

e
"

]

Share a document as a PDF file on Mac

¢

-

]
o,

If your Mac restarts and a message appears

)
o

=

Use DHCP or a manual IP address on Mac

_‘
2

e
"

Use a Bluetooth headset with your Mac

o)

&

Leave a Family Sharing group on Mac

—~
)
o,

Create a burn folder to hold files to burn to a CD...

o

G C

Show All Help Topics

Scroll down the Ruskin list and select an item to locate. Ruskin will open the toolbar menu and point to the option in
the dropdown menu.

@ Ruskin File Instruments Help

Open dataset ann e

EVatt 3 [=| Export > Annotations

e 5 =l Annotations > Comment regions

e e =] Annotations = Profiles

I=| Profiles = Full Profiles

Profiles >
& et Full Profiles | =l Profiles > Downcasts
.%I Text Downcasts =l Profiles > Upcasts

[ Rel8 R Upcasts *-'
Raw BBy B} St YOUT Mac speak announcements
. — — @ Mark up files on Mac

You can execute the located option right away.
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4.2 Release notes

Click on Help > Release notes to open the Welcome window. It will outline new features, improvements, and bug fixes
associated with each release version.

[ Release notes 23

Release Notes Did you know...

2.19.1 Ruskin Updates

Release date: Oclober 21 2022 Ruskin can automatically notify you that a newer version is available.
If you do not have a breadband cennection and/or are unable to install the Ruskin
updates, update notifications are available via email. To receive these notifications,

Bug fixes send an email to: support@rhr-global cam subject: "Ruskin update request".

* RSK-9274 - Unable to enable instrument in local time when the clock has a positive UTC ofiset
Let us know!

2.1 9.0 If you have problems or praise, please let us know. Either use the "Help/Comment
on Ruskin" menu item or write to support@rbr-global.com.
Release date: October 04 2022

New Features
RBRtridente

RBR's new RBRiridente multi-channel optical sensor is now fully integrated inte Ruskin. Connect your sensor to change its
sampling speed and record data in real-time.

Did you know?

" 5 = 2 Previous Next
You can simulate a sensor even if you don't yet have one. Ruskin lets you simulate the RBRtridente as a standalone sensor
or as part of a larger integration. We've updated Ruskin's autonomy engine to let you easily plan deployments using this
tool too.

Other notable additions

Added RBR Instrument Guide (RIG) for RBunan‘z" APT and Standard instruments

Added Quick Start Guide (QSG) for RBRquartz® APT

Updated Quick Start Guide (QSG) for RBRfermata

Updated Ruskin User Guide (RUG) for RBRcada®, Compact instruments, and Standard instruments

.
.
.
.

Improvements
» RSK-6356 - Added link to release notes to get full history Calibration in three weeks or less.
+ RSK-7886 - Added copy/paste functionality to RBRquartz® calibration coefficient tables
* RSK-8672 - Added channel indices to RSK analysis data table Guaranteed.
* RSK-8703 - Removed column auto-sizing on Excel exports 4 - 1
* RSK-8756 - Release notes window was renamed from 'Welcome' to ‘Release notes' Click the vcallb_ratlon tab and select
+ RSK-8762 - Added dialog to view all user activated feature codes “request a calibration quote™ to get started.

Click here to see all Release Notes

Click the link at the bottom left to see the full history of the release notes. The link will take you to the RBR support
page.
Alternatively, scroll down to see brief recaps of the release notes from all previous versions.

Click the x to close the Release notes window and return to the Navigator mode.
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4.3 Documentation

Click on Help > Documentation to open the menu tree. Browse through a variety of guides available for instruments
and accessories.

Help

Ruskin v2.18.0.202204261717

Release notes

Sensors

Quick Start Guide |

Ruskin User Guide

Comment on Ruskin...
Standard Instruments

Check for updates.... RBRquartz®
Enter Feature Code... RERlegato® glider/AUV CTD
| ‘ Legacy Instruments
Cables
RBRfermata

L Y " AV VI VI v

Please note that you can always access the most current revisions of RBR documents on the RBR website.

& rbr-global.com/support/documentation/

PRODUCTS ¥ SALES SUPPORT ABOUTRBR ¥ RESOURCES ¥ CONTACT US Q

User Manuals

Ruskin User Guide: Standard Instruments®
o RBRvirtuoso*

RBRduo?

RBRbrevio®

RBRconcerto®

°

o

o

RBRmaestro®

o

o

RBRquartz?

Ruskin User Guide: Compact Instruments?
o RBRsolo®
o RBRduet’

Ruskin User Guide: RBRcoda®

Logger® Command Reference

RBR Instrument Guide: Standard Instruments?
o RBRvirtuoso®

o RBRduo’

o RBRbrevio®

o RBRconcerto®

o RBRmaestro?

4.4 Commenton Ruskin

There is an advantage to sending a bug report from within Ruskin because this allows you to include the diagnostic
logs, RSK datasets, screenshots, and any other files that could help us reproduce the problem and find the solution as
quickly as possible. Follow the steps below.

RBR#0006106revK 16


https://rbr-global.com/support/documentation/

Steps

1. Click on Help > Comment on Ruskin... . The Feedback to RBR form will appear.
Enter your identification information.

Enter a brief summary of the problem.
Provide a detailed description (serial number for the instrument, overview of the problem, deployment details,

initial tests, and, for software bugs, steps to reproduce the issue)
Include any attachments, if required.

6. Verify all the information entered and click Submit.

Mo

@

e @ Feedback to RBR

Report bug or enhancement

O General user Name: | customer Email address: Customer@email.com

RER employee
Summary:
Instrument type - problem statement

Description:

1. Serial number

2. Overview of the problem

3. Deployment detalls

4, Initial tests

For RSK / Ruskin issues

5. Steps to reproduce the issue

Attachments: Include any datafiles (RSK or HEX) and or photos of the issue

Attachments:

Attach...

Cancel | Submit |

4.5 Check for updates

Click on Help > Check for updates to search for the latest software version.

Progress Information

1 Checking for Ruskin updates...

37% completed

If your software is up-to-date, no further action will be required.

If an update is found, Ruskin will offer to install it. Follow the prompts. Restart Ruskin for the updates to take effect.
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4.6 Feature codes

Sometimes, RBR may release new features to certain users only, as a beta trial. This includes:

« Featuresin early development

« Features supporting a new product, in preparation for the product launch
+ Features requested by a specific customer

Usually, the goal is to get feedback and improve the feature before its official release. Contact your sales representative
or RBR support team at support@rbr-global.com if you have questions about your feature code.

Steps

1. Click on Help > Feature codes...
The Feature codes window will appear.

) [ Feature codes

Feature codes

Enter a provided feature code

Enter feature code ADD

Code Description

*All changes require a restart to take effect

Dismiss

2. Enter the feature code provided by RBR.
3. Click ADD.

If the code is correct, Ruskin will save the feature in the local database and enable it. In most cases, you will have access
to the new feature immediately, without restarting Ruskin. Otherwise, you will receive any additional instructions at the
time when you receive the feature code.

Errors

1. The feature code is not valid.

This error may indicate the code was entered incorrectly or it is not compatible with the current version of
Ruskin.

2. Thefeature code is already enabled.
This error may occur when another user has already activated this code.
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5 Quick start

Ruskin Desktop version is designed for computers and laptops. It generates dataset files which include raw
measurement data, firmware and software versions, dates and times, sampling settings, power settings, measured and
derived parameters, errors and events, calibration coefficients, and diagnostic information, offering the fullest Ruskin
experience.

5.1 Simulate an instrument

Ruskin can simulate most instruments and sensors that RBR produces. We recommend that you experiment with
different simulated options before enabling a schedule for your actual deployment. This practice will also help you
become more familiar with how an RBR instrument interacts with Ruskin and how to configure its settings and
features. Work with simulated instruments the same way as you work with a real RBR instrument, configuring,
calibrating, and fetching data.

& Currently, simulated instruments cannot be enabled or downloaded. For more information, see Deploy your
instrument.

Steps
1. From the Instruments menu, click Simulate an instrument.

@ Ruskin File Instruments Help

°oe

03 Navigatﬂf-

=—— Update instrument firmware...
b i Instruments

©simRBERsolo® Automatic tasks >
OsimRBReoda®
i MLM Utilities >

o B Datasets ||
oy 209681...1600 [

The Configure simulated instrument dialog box will appear.
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[=] [ ] Configure simulated instrument

Simulate an instrument

Late 2017 - RBRsolo® T

Compact instruments = Standard instruments ~ RBRquartz =~ Sensors  Legacy

Model Channels

O RBRsolo® T
RBRsolo® D
RBRsolo® DO
RBRduet® T.D
RBRsolo® Tu
RBRsolo® PAR - Licor
RBRsolo® PAR
RBRsolo? rad
RBRduet® T.ODO
RBRduet® T.ODO|fast
RBRduet® T.ODO|slow

Options

2. Click your instrument family and make your selections.

Click OK to proceed.

4. Your instrument will appear under Instruments in the Navigator view. Simulated instruments will have a prefix
"sim" in the front of their name.

w

4=+ Navigator - O
e i Instruments
ZsimRBRsolo? 805925
ZsimRBRcoda® 909036 -
simRBRconcerto® 805833
wiim MLM

g g Datasets
lorp 209681...1600
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The instrument properties will be displayed on the right, under four tabs.

El simRBRsolo® 905925 i3

Configuration Information | Calibration | Parameters

Schedule Sampling

Status: Mot enabled Mode:
Speed: « Rate  2HZ <

Clock: 2022-04-28 15:45:52-04:00 utc Local
Start: 2022-04-28 ¥ 2:00PM 3 Now

End:  2022-09-23 [l 147 days W +616 days
Power

Battery Lithium thienyl chloride

(3]

131

External:  Mone

b Sample power details

Memory used: 0%

Revert settings Use auto-deploy settings

° The Configuration tab displays status, clock, sampling mode and speed, power options, and deployment
estimates based on these parameters

° The Information tab includes general details, such as the instrument model, generation, serial number,
firmware version, power source, battery status, and the channels

° The Calibration tab allows access to the current calibrations for each channel in the instrument

° The Parameters tab outlines default values used by the sensor when performing computations and
derivations

5. Familiarise yourself with the instrument by changing configuration options and comparing deployment
estimates. Select the desired configuration using the dropdown options or entering the values manually in the
fields provided. For simulated instruments, the Plot window will remain empty unless you click the Fetch

button [
6. Manage multiple instruments by switching between them in the Navigator window.

@ Toremove a simulated instrument from Ruskin, right-click it in the Navigator window, and select Disconnect
from instrument. You can also use the Instruments menu.
Alternatively, simply close its Plot tab by clicking the X. The instrument will disappear from the list.

5.2 Deploy yourinstrument

Before using your RBR instruments, you may want to experiment with different options by simulating your instrument
on Ruskin.

When you are ready to use your physical RBR instrument, follow the steps below to ensure that you measure exactly
what you want on the first attempt.
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Steps

o

5.3

Open the instrument and remove the housing. See "Opening and closing a compact instrument" section in the
RBR Compact Instrument Guide for more details. The Guide is available on Ruskin under Help >
Documentation.

Locate a USB-C port inside of the instrument.

Plug one end of the USB cable (USB-C to USB-C, provided with your instrument) into this port and the other, in
the USB port on your computer.

The instrument will appear in the Navigator view after a few seconds. The properties for the instrument will be
displayed in the Properties window, grouped under four tabs: Configuration, Information, Calibration, and
Parameters.

If you are using the instrument for the first time, you can use either the default preferences or specify your own.
For more information, see Preferences > General. You can change them at any time.

Click the instrument you want to use. Verify that it contains the expected sensors under the Information tab.
Click the Calibration tab to view or modify calibration coefficients.

Click the Configuration tab and go to the Sampling section to select the mode and speed of measurements.

@ Ruskin will allow a deployment to run until the instrument can no longer sample. This could be due to a
full memory or due to power supplies being exhausted. It will display the estimated battery usage and
storage capacity based on the parameters you enter. The green widget next to End will indicate the
number of days your instrument would be sampling, along with the icon representing the limiting
factor, battery or memory.

Carefully consider this information before you enable a deployment schedule. For more information,
see Schedule.

Click the Enable button at the bottom of the Configuration tab to take samples according to the schedule that
you specified.

Your deployment will continue until the battery runs out, the memory is full, or you stop your schedule
manually.

When your deployment stops, click the Download... button at the bottom of the Configuration tab to transfer
all the sampled data from the instrument to your computer. For more information, see Download.

As soon as you download a new dataset, it will appear in the Navigator window. Refer to Datasets for details on
managing and analysing your data.

@ Torestore aclosed connection to an instrument on Ruskin, click Instruments in the Navigator
window. A list of all instruments physically connected to your computer will appear in the Properties
window.

Find your instrument and deselect its checkbox, and then select it again.
Your instrument will re-appear in the Navigator window.

Recover your instrument and download data

When deployment is complete, recover your instrument and follow these steps to download your data.

o

Flooded instruments may be under pressure and opening them may be dangerous. Take precautions when
opening an instrument after deployment.

RBR#0006106revK 22



Steps

1. Start Ruskin.

2. Carefully open the instrument and remove the housing. See "Opening and closing a compact instrument"
section in the RBR Compact Instrument Guide for more details. The Guide is available on Ruskin under Help >
Documentation.

3. Locate a USB-C portinside of the instrument.

4. Plugone end of the USB cable (USB-C to USB-C, provided with your instrument) into this port and the other, in
the USB port on your computer.

5. Theinstrument will appear in the Navigator view after a few seconds.

6. Navigate to the Configuration tab and click Download... . See Download for details.

Memory used: <1% Download...

Enable Revert settings Use auto-deploy settings

7. Save the file to your local drive. See Preferences > General on steps to set up your default location.
8. Evaluate your data. See Analysis for details.

Disconnect from your instrument

To disconnect an instrument from Ruskin, right-click it in the Navigator window, and select Disconnect
from instrument. You can also use the Instruments menu.

Alternatively, simply close its Plot tab by clicking the X. The instrument will disappear from the list. Please note that
you will be able to reconnect to it at any time because Ruskin remembers the port of a plugged instrument.

Reconnect to your instrument

To restore a closed connection to an instrument on Ruskin, click Instruments in the Navigator window. A list of all
instruments physically connected to your computer will appear in the Properties window.

Find your instrument and deselect its checkbox, then reselect it again. Your instrument will re-appear in the Navigator
window.

i+ Navigator = mE [ Connections 22
i Instruments
wEa MLM
v & Datasets Port Status RF latency (s) Device
o 203672...1240 ¥ [devftty.usbmodem1412101  Connected to RBRconcerto® 209681 0 Logger
oy 208718...time
[ 209718...1210

Remove your instrument
To completely remove your instrument from Ruskin, unplug it from your computer.

Alternatively, deselect the checkbox next to your instrument, and Ruskin will disable transport to its port.

i+ Navigator = O || = connections 52
i Instruments
wEa MLM
v & Datasets Port Status RF latency (s) Device
o 203672...1240 /devftty.usbmodem1412101 Transport disabled 0 Logger
o 209718...time
o 209718...1210
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6 Configuration

Use the Configuration tab to set up your deployment parameters.

After setting up a desired schedule, click Enable. New values will replace all previously stored schedule parameters. To
return to previous settings, click Revert settings.

To apply the same schedule to multiple instruments, set up the firstinstrument and click Enable. Connect all other
instruments to Ruskin and click Use auto-deploy settings. Now all instrument will run on the same schedule, including
logging times, power options, and sampling parameters. To return to previous settings, click Revert settings.

Memory used: <1% Download...

Enable Revert settings Use auto-deploy settings

@ Tochange aschedule already enabled, stop the instrument. If the data acquired up to this point and stored on
the instrument has value, download it to a file and save at your preferred location. After that, make your
changes and click Enable.

6.1 Update firmware

Ruskin automatically checks if your instrument firmware is up-to-date. Updates may be critical, routine, or customised.

If a newer version is available and this update is critical, the Update firmware button and a warning message will
appear at the top of the Configuration tab.

Configuration Information | Calibration | Parameters

Firmware Update

Update firmware

See Critical firmware updates for details.

6.2 Schedule

The Schedule section includes four fields: Status, Clock, Start, and End.

Schedule

Status: Stopped, user request

Clock: 2022-05-10 15:09:00-04:00 utc Local
Start: 2022-04-14 ¥ 7:58 PM o MNow

End:  2023-02-14 [ 306days 0 NA
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Status

The Status field displays the current state of your instrument.

Status

Not enabled
Configuring instrument
Schedule enabled
Paused

Logging in progress

Logging, memory full

Stopped, schedule complete

Stopped, memory full

Stopped, user request
Failed
Battery failed

Clock

When you start a deployment,

Description

A deployment has not been enabled.

Ruskin is writing the deployment configuration to the instrument.

A deployment has been enabled, but the start time has not yet been reached.
A deployment has been enabled, but a gating condition has not been met.

A deployment has been enabled and the instrument is currently obtaining
samples and recording them to memory.

A deployment has been enabled and the instrument is currently obtaining
samples, but they are not being recorded to memory as there is no available
space. Data continues to be transmitted over the chosen realtime link.

A deployment has reached the end time and so has been stopped.

The memory has been completely filled with samples and so logging has been
stopped.

An enabled deployment has been stoped by user intervention.
An internal error has occurred during a deployment.

An internal error with regarding the batteries has occurred.

you can automatically set the instrument time from your computer. Select UTC or Local

time, depending on your preferences.

Start

Specify the Start date using the dropdown calendar, and the Start time using the up and down arrows. Alternatively,
check Now to start logging as soon as the Enable button is clicked.

@ Tomanually edit the originally set date and time values, select and then clear the Now checkbox.

End

The End date is calculated by Ruskin autonomy engine and indicates when your deployment is likely to stop. This is
based on sampling schedule, mode, and power selections . Ruskin autonomy engine provides feedback on which
parameter (power or memory) will be exhausted first.

End:

2019-09-23 gl 115 days H +496 days
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The parameter in the green bar is the true deployment estimate. In the example shown, your deployment will last 115
days, until the battery is exhausted.

& Deployment estimates on Ruskin assume new batteries. Your real deployment times may be shorter if the
batteries are not fully charged.

The parameter in the orange bar indicates how much longer the deployment could last if the preceding parameter
were not a factor. In the example shown, if your instrument were still powered after 115 days, it could continue logging
for 496 days more, until the memory becomes full.

@ Ifthe End logging date is power dependent and you know that the instrument will be operating under very
cold conditions, you may want to lower the demands on the battery by lengthening your sampling period or
opting for different battery chemistry.

Ruskin autonomy engine

Ruskin autonomy engine relies on several parameters to estimate the deployment end date: sampling rate, power
options, and memory. One of the key factors is battery life.

Battery life prediction is a complicated issue. In RBR instruments, it is a strong function of the type of instrument, type
and number of sensors attached, sampling mode (sampling rate, gating conditions, realtime data collection), and water
temperature during the deployment. Manufacturer's data for the batteries may not reflect the way batteries are used in
RBR instruments, and thus, are not always informative.

Autonomy figures depend on the power draw of the instrument, as well as the derated capacity of the battery pack.
Batteries are derated to 4°C. These values differ for different battery chemistries. For the most accurate deployment
estimates, select the same batteries from the dropdown menu as installed in your instrument.

Ruskin calculates the expected battery usage for the instrument during setup . The nominal capacity of each type of
battery is described in the Power section and is given in mAh at room temperature. Battery voltage does not decrease
linearly and is therefore not an accurate indicator of battery capacity.

RBR tested batteries of various brands at 6°C; all of them were able to provide the threshold capacity defined in the
Power section. View these predictions and further de-rate the batteries if the expected deployment is in cold water.

The software will warn you if the expected battery usage for a particular deployment scenario is approaching the
theoretical potential mAh.

® Warning

There is insufficient power for the deployment.

Would you like to proceed?

The software will not prevent your instrument from being started even if a warning is given. However, adjusting
deployment parameters or replacing the batteries may help extend deployment times.
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6.3 Power

The Power section includes battery chemistry options and information on sampling power. Ruskin autonomy engine
uses these parameters to estimate deployment life.

Power
Battery:  Lithium thionyl chloride o

b Sample power details

Battery

The Battery dropdown menu shows available chemistry options for internal batteries. The list depends on your
instrument.

RBR ships all new instruments with batteries of the highest capacity for the instrument type already installed.

© Mixing batteries of different chemistries, brands, and age will reduce performance and potentially damage the
instrument. Improperly matched batteries may become overheated, leak, or even explode.

RBR instruments can use most chemistries of AA batteries.

A Lithium thionyl chloride batteries are only recommended for T, D, and T.D instruments. Other sensors will not
work correctly on this type of battery.

Typically, RBR instruments are shipped with EVE ER14505 lithium thionyl chloride or Energizer L91AA lithium iron.
Select your battery chemistry from the dropdown list.

Power
CENCTHE +/ Lithium thionyl chloride |
Externals Lithium iron |
Alkaline
Li-ion
b Sampl
Pl NiMH
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Battery chemistries

Name Chemistry
Lithium thionyl chloride Li-SOCl,
Lithium iron Li-FeS,
Alkaline Zn-MnO,
Li-ion Li-NiMnCo
Nickel metal hydride Ni-MH

Voltage (V)
3.6
15
15

3.6
1.2

mAh*
2700

3500
2500

750
2400

*The nominal capacity of each type of battery is given at room temperature.

Deployment estimates

Ruskin estimates autonomy figures based on the power draw of the instrument, as well as the derated capacity of the
batteries. Batteries are derated to 4°C . These values differ for different chemistries (see above). For the most accurate
deployment estimates, select the same batteries from the dropdown menu as installed in your instrument.

Alternatively, use Ruskin to simulate your instrument with different batteries and find which chemistry works best for

your deployment.

& Battery cells of the same chemistry but from different manufacturers may have different performance. If the
nominal capacity of the battery model you are using is lower than outlined above, your actual deployment

may be shorter than the estimate.

@ Replace batteries before each deployment to maximise the operational time and prevent data loss.

Sample power details

Click on the arrow to open the information drawer with sample power details, such as energy per sample, sample

duration (if applicable), and sleep power.

* Sample power details

Eneray per sample:
Sample duration:
Sleep power:

260 ms
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6.4 Sampling

The Sampling section includes three fields: Mode, Speed, and Rate, as well as several optional fields available with

certain sampling modes.

Mode

Sampling

Mode:
Speed: Rate

Continuous

2Hz

Depending on your instrument, different dropdown options may be available. See Tide and Wave for information on

how to configure these modes.

RBRsolo® T | fast8:

Sampling

Mode:

Speed: v Rate  8Hz

L4

Speed and Rate

RBRsolo® D | tide: RBRduet’ T.D | wave:
Sampling 3
—  Continuous -
Mode: Tide S
Speed: @ Rate  16Hz G vwave |
~ Speed: b4 Rat 4Hz
Duration: 00:00:01 5 pECTENEY Tt L
Interval: | 00:05:00 : Duration: | 1024 a
Interval:  00:30:00 C

These are the only two parameters you need to configure Continuous sampling mode.

Check Speed to select the sampling Rate in Hz from the dropdown menu. The default option is always the highest
instrument rating; for example, | fast16 will default to 16Hz.

Sampling
Mode: Continui

Spead: Rate

THz
2Hz
4Hz
8H

F.a
+ 16Hz I

@ All |tideand |wave instruments can sample at rates of 2, 4, 8, or 16Hz.
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Uncheck Speed to enter the sampling Rate manually in hours, minutes, and seconds (HH:mm:ss format). The fastest
rate to enter manually is 1s. Type the numbers in, or use the up and down arrows.

Sampling

Mode: Continuous (]

Speed: | Rate |00:00:02 %

6.4.1 Tide

Tide sampling mode is similar to Average, as the instrument will also collect data at a certain rate, and then average
those samples to produce a single value to store on the instrument. However, when set to Tide, the instrument uses
averaging to remove wave noise data from pressure measurements.

() Onlyinstruments with the | tide16 feature support Tide sampling mode.
In addition to Speed and Rate, there are two more parameters required for Tide mode: Duration and Interval.
Duration specifies the time range over which to average. It must always be longer than Speed .

Interval is the repetition period for performing the averaging. It must always be longer than Duration .

There are two versions of sampling controls for Tide sampling mode: simple and advanced. Make your selections in
Preferences > General.

Simple sampling controls

When using the simple version, select Speed, Duration, and Interval from Sampling
pre-defined options in three dropdown menus. ek | Tide e
Speed: 16Hz (2]

In the example shown, the sampling rate selected is 16Hz (16 samples per
second). The instrument will be logging for a duration of one second, then
pause and average the sixteen samples collected. After an interval of five Interval:
minutes, it will start logging again, repeating the same cycle.

Duration: ~ 00:00:01 o

00:10:00
00:20:00
00:20:00
01:00:00
02:00:00
06:00:00
24:00:00
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Advanced sampling controls

When using the advanced version, select two or all three parameters manually. Sampling
Mode: Tide 8
All parameters are the same as in the previous example. Speed: Rate 16Hz B

Duration:  00:00:01

£> (£

Interval: | 00:05:00

() Atevery Interval, the instrument records only one sample, averaged over all samples collected during the
period of Duration. The rest of the samples are discarded after averaging is performed.

6.4.2 Wave

Wave sampling mode is similar to Burst, as the instrument will also collect a specified number of samples at a specified
rate, and repeat this operation at a specified interval. When in Wave mode, the instrument takes multiple pressure
readings in a burst and reconstructs the surface wave time series. This mode records both tide and wave information.

() Onlyinstruments with the | wavel6 feature support Wave sampling mode.

Speed or Rate are parameters defining individual pressure readings.
« The highest possible frequency visible in the data is limited to 2 the sampling rate. However, this mathematical
limit cannot be achieved because of wave attenuation, and real data are actually lower.
« The sampling rate defines the resolution of the frequency spectrum which can be calculated from the wave

data.
« The sampling rate, together with the burst duration, defines the lowest frequency which can be assessed in a

wave burst.

In addition to Speed and Rate, there are two more parameters required for Wave mode: Duration and Interval.
Duration specifies the number of samples to record.

Interval is the repetition period for performing the burst. It must always be longer than the time it takes to obtain
the number of samples indicated in Duration.

& Consider unique aspects of deployment environment when setting up Wave sampling mode.
For example, while a 30-minute interval tends to work in most cases, shorter intervals may suit better when
encountering ocean swells which have longer wavelengths than noise but shorter than tide.

Furthermore, you may enter Instrument altitude and Mean depth of water to estimate possible wave periods for
your deployment. These parameters are not mandatory for the instrument to work, but allow you to get an idea of
what to expect.

Instrument altitude is the actual height of the instrument in metres above the seabed. This is defined by
deployment requirements, and the instrument must be physically affixed at this height during the installation.
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° This parameter is stored on the instrument and used to compute wave statistics for pre-deployment

analysis.

Mean depth of water is an estimate of the average water depth in metres, used for the initial prediction of wave
frequency. It must always be greater than Instrument altitude.

° This parameter is not stored in the logger and only used to compute wave statistics. It is adjusted post-

deployment th

rough the RSK file.

o Ruskin will calculate the actual mean depth of water from the instrument altitude and its depth
measured during the deployment.

There are two versions of sampling controls for Wave sampling mode: simple and advanced. Make your selections in

Preferences > General.

Simple sampling controls

When using the simple version, select Speed, Duration, and Interval from pre-defined options in three dropdown

menus.

A common configuration is 4Hz sampling for 4096 samples every 30 minutes.

Sampling
16Hz
Mode: 8Hz

2Hz I
00:00:01
00:00:02 I
00:00:05
00:00:10
00:00:30
00:01:00
00:10:00
00:30:00
01:00:00

Duration:

Interval:

Sampling

Mode:

Speed:

Interval:

512

1024

2048 I
8192

16384

32768

Sampling
Mode:
Speed:
Duration:

Interval:

Wave
00:05:00 |
00:10:00
00:20:00

01:00:00
02:00:00
06:00:00
24:00:00

Enter Instrument altitude and Mean depth of water manually. Estimates for wave statistics will be immediately
displayed: maximum wave frequency and minimum wave period (essentially, they reflect the same concept because
period = 1/frequency). These values can be adjusted post-deployment through the RSK file.

Sampling

Mode: Wave
Speed: 4Hz
Duration: 40986
Interval: 00:30:00

Instrument altitude (m)

Mean depth of water (m)

Maximum wave frequency 0.2252 Hz
Minimum wave period 4.44 secs

RBR#0006106revK

32



Advanced sampling controls
When using the advanced version, enter all or some parameters manually.

This option allows more flexibility with your values. For example, with a rate of 4Hz and a duration of 4096 samples, the
instrument will be sampling 17 minutes 4 seconds. You can set up near continuous sampling by setting the interval to
17:05. Logging will be on every second except the one remaining second of the interval, and then start again.

Sampling

Mode: Wave

L8

L4

Speed: + Rate dHz 0.5 Instrument altitude (m)

10.0 Mean depth of water (m)

L4

Duration: 40986

"~ Maximum wave frequency 0.2183 Hz
Interval:  00:17:05
Minimum wave period 4.58 secs

@ Thetimestamp of the burst for both Tide and Wave datasets is the beginning of the burst.

Deployment depth of | wavel6 instruments

@ Thebasicruleis to place the instrument as close to the surface as possible without it emerging from the water
due to large waves or low tides.

Attach your | wavel6 instrument to a suitable support below the surface of the water, such as a dock or other rigid
mooring, to completely immobilise it.

Enter the expected mean depth of water and the known instrument altitude (height above the seabed). From these
values, Ruskin will estimate wave frequencies and wave periods that your instrument could measure (period =1/
frequency). On data retrieval, Ruskin will calculate the actual mean depth of water from the instrument altitude entered
and its depth measured using the pressure transducer, and then use this actual depth for computing all wave statistics
during deployment.

The physics of what a pressure transducer can measure depends on the height of water above as well as the depth of
water below it. High frequencies attenuate very quickly with depth. The depth of the deployment is critical in
determining frequencies/periods of the wave data the instrument will be able to capture. It is the depth, not orientation
of the pressure transducer that affects these measurements.
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Instrument fixed to a dock below the water surface

Attenuation

Depth (m)
0 5 10 15 20 40
1.000 -
0100 — 30 sec
20 sec

—10 sec
—b5 sec
— 2.5 sec

0.010 —1 sec

0.001

Wave attenuation as a function of depth for various wave periods
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6.5 Ranging sensors

The Ranging sensors section has two dropdown menus, Sensor and Range.

The former displays the name and index of the channel, which for the RBRcoda® Tuis always Turbidity (1). The latter
specifies the gain level used for the deployment. The units of measurement are NTU (Nephelometric Turbidity Units).

Ranging sensors

Sensor:  Turbidity (1)
Range A |
2500 NTU
500 NTU
126 NTU
25 NTU

Set Range to Auto to enable auto-ranging setting. Your instrument will change the gain setting on the front-end
amplifiers to the range most appropriate for its environment. To display the range change events, select Diagnostic

A

from the dropdown under the Events button in the Plot window toolbar.

Range change events are displayed as "RANGE XX Units" where XX indicates the current range and units are the units of
measurement, for example: RANGE 500 NTU. For | fast sampling, where the change may be occurring over a number of
samples, the label will read, "RANGE CHG", followed by the final range change event.

Alternatively, select a fixed gain setting to maintain the same setting throughout your deployment.

6.6 Download

The Download... button is located next to the Memory used bar, at the bottom of the Configuration tab.

|. Memory used: <1% | | Download...

Enable Revert settings Use auto-deploy settings

You can download data from your instrument at any time. However, it is especially important to do so when you stop a
schedule. All the data on the instrument will be erased as soon as you enable a new deployment.
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Steps

1. Click the Download... button.
A dialog box will appear.

209681_20220531_1106.rsk

% Downloads B -

Ruskin RSK (*.rsk) &

2. Enter a name for the data file in the Save As field, or accept the default name.
By default, the RSK file name uses the Ruskin file naming convention (see RSK files).
3. Select the download location from the Where dropdown menu, or accept the default location.

& RBRrecommends storing your data on a local drive rather than a network storage drive. Cloud storage
options such as GoogleDrive and Dropbox may extend download times.

4. The new dataset will appear automatically in Navigator window under Datasets.

5 Mavigator - g
v i Instruments

' RBRconcerto?® 209681

CsimRBRconcerto? 905195

OsimRBRguartz? 907084

OsimRBRconcerto® 909471
OsimRBRconcerto® 907504
OsimRBRmaestro® 901261
s MLM
5 Datasets

oy 209681...1106

The Properties view will change to the new dataset, with the following tabs: Analysis, Overview, Channels, and
File info.
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All the data stored on the instrument at the time of the download will be automatically plotted in the Plot

window.

RBR#0006106revK

Analysis Ove rview} Channels} File infn]

Sample 143
Time 2018-02-02 10:53:33.231 (UTC-5:00)

Display statistics

Number of samples o
Channel Yalue Unit
Temperature 14.5291477 °C
Pressure 15.1366514 dbar
Sea pressure 5.0041514  dbar
Depth 4.9633444 m

il RBRconcerto? 209681 i 203672_20220517_1240.rsk 32 . il 209631_20220414_1eou.rsq T 209631_20220531_1106.rsk1 =0
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3
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Lot 9.930
200001 -g.120 }
T 1700 18:00 19:00 20:00 2100 22:00 23:00 00:00 0L:00 0z2:00
Time
o

37



5. When you download data again while on the same schedule, the RSK file will pick the same data and append it
with any new data stored since the last download.

& ) Append Download

There is an existing RSK with the same deployment:
209681_20220531_1106.rsk

Do you want to append to the existing file?

Mo Yes

6. Go to the Overview tab to add a comment for the download. Enter your message and click Save comment.

Analysis Overview _Channels] File info]

File location

[Usersfichapman/Downloads/209681_20220531_1106.rsk

Logger Deployment Continucus
Model: RBRconcerto® Time offset: UTC-4:00 Period: 2 Hz
Serial: 209681 Time drift: -1867ms
Firmware: 1.141 Deployment start time: 2022-05-17 15:39:00
Markers First sample time: 2022-05-17 15:39:27
Errore. 0 Last sample time: 2022-05-17 15:39:29 Gate
Warnings: 1 First event time: 2022-05-17 15:39:27 Gate: none
Information: | 2 Last event time: 2022-05-17 15:39:31

Samples: 6

Diagnostics: 0

Comment

Download 2

Save comment
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6.7 Use auto-deploy settings

When working with a large number of similar instruments, Ruskin offers various automatic tasks, which can be set up
from the Instruments menu on the top toolbar.

This feature may be convenient when you need to deploy several instruments with the same sampling capabilities.
Select an instrument to use as the model and configure it. This will be your model schedule. Verify that these settings
meet your requirements and all values are entered correctly.

@ To confirm which auto-deploy parameters are set on Ruskin, go to Instruments > View auto-deploy
settings... . The Auto-deploy settings box will open, with saved parameters outlined.

When you connect to an instrument with same sampling capabilities as the model instrument, Ruskin will configure it
to match the the model schedule.

If your were connected to an instrument before setting up your model schedule, you can click Use auto-deploy
settings to apply them to that previously connected instrument.

|. Memaory used: =1% | Download...

Enable Revert settings Use auto-deploy settings

Click Revert settings when you wish to return to a previously configured schedule.

A You cannot use Revert settings after clicking Enable. To change a schedule already enabled, stop the
instrument, restore old values manually, and click Enable again.

Enable each instrument individually to start deployments.
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6.8 Enable/ Stop

Ensure that your instrument is ready to be deployed before enabling a schedule. See Deploy your instrument.

To allow the instrument to start logging, click Enable. This button is at the bottom left of the Configuration tab.

Memory used: <1% Download...

Enable Revert settings Use auto-deploy settings

The Enable button will now read Stop. The status will become "Schedule enabled" or "Logging in progress", depending
on the configuration.

g T T ™
Configuration _Information | Calibration | Parameters |

Schedule Sa
E]s
Clock: 2022-09-02 14:44:37-04:00 uTc Local

Start: 2022-09-02 ¥ 2:00 PM o Mow

Power

Battery:  Lithium thionyl chloride

b Sample power details

| Memaory used: 0%

Stop

Logging will start when one of the following occurs:

« The Now button is checked
« The Start time arrives
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If you click Enable, and the instrument memory is not empty, you will see a warning.

@ Warning

The contents of memaory will be erased!

Erase and enable logging

Before proceeding, download the data from your instrument (see Download). If you are sure that the information is

saved or not needed, click Erase and enable logging.

A All editable fields become greyed out after you enable a schedule.

To change any deployment parameters, stop your instrument, adjust the settings, and start a new

deployment.

To manually stop the instrument, click Stop.

|-Memor'u,r used: <1% |

stop

Download...

Logging will stop on its own when one of the following occurs:

» The End logging time is reached
» The power source is removed or depleted
« The memory is filled
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7 Information

Use the Information tab to view general information for each of your instruments, such as as model, generation, serial
number, firmware version, power source, and the channels.

Configuration | Information . Calibration | Parameters |
Instrument details Channels
Model: RBRsolo® # Parameter Units Sensor Ranging
Generation: Mid 2020 1 Temperature °C Marine MNone
Serial: 2015622
Firmware: 1.069
Limk: USB
Power
Source: USB =
internal:  2.650V o Most recent RBR calibration certificates =~ Download

In the Instrument details section, find the model, generation, and serial number for your instrument, as well as the
firmware version installed and link used.

Refer to the Power section for the power source, power type, and voltage.

Under Channels, confirm measured and derived parameters for your instrument.
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8 Calibration

The Calibration tab displays calibration coefficients for each parameter, and the date and time of the last calibration.

Select a sensor from the Parameter dropdown menu to display its calibrations.

Conﬁguratian'lnfurmation Calibration . Parameters

CRIPEEE o/ 1: Temperature

Calibratic  2: Pressure 67
Label Value

co 3.5000000 E-3
c1 -250.0000000 E-6
oz 2.7000000 E-6
c3 23.0000000 E-9

Check calibration expiry Reqguest calibration quote

RBR calibration certificates contain calibration equations, coefficients, and residuals for each sensor.

RBR recommends calibrating your instrument before any critical deployment, periodically once a year, or if you suspect
the readings to be out of specifications.

Discuss your calibration requirements with RBR. In some cases, the instrument may need to be returned to RBR to have
it checked and re-calibrated.

To contact RBR for our current calibration fees, click Request calibration quote. A Request for quote dialog box will
appear.
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1) [] Request for quote

Request for quote

€ Simulated instruments do not require calibration from RBR. All contact details must be specified.

Contact details

Name: Address:

Email address:
Phone:

Organization:

Sensor list: Other information:

Pressure Enter a longer description here.

Request preview:
Request for calibration quote: simRBRsolo® 902444

Requested sensor calibrations:
Pressure

Cancel

Verify that all information is correct and click Submit.

Simple calibration controls

When using the simple version, you will be able to view and edit only the main calibration coefficients, displayed as "C"
values: C0, C1, C2, C3.

Configuration | Information | Calibration Parameters |

Parameter  3: Pressure 8

Sensor serial number: N122080
Calibration date: 2022-02-03 19:17:572Z

Label Value

co -38.4045200
Cl 2.3795940 E3
cz 27.9242860
c3 -27.382B380

Check calibration expiry Request calibration quote
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Advanced calibration controls

When advanced calibration controls are enabled in Preferences > General, you will be able to view and edit both main
and dependent coefficients. Dependent coefficients are displayed as "X" values: X0, X1, X2, etc.

Configuration | Information | Calibration Parameters

Parameter  3: Pressure a

Sensor serial number: N122080
Calibration date: 2022-02-03 19:17:572

Label Value Label Value

co -36.4045200 X0 10.19%1000

cl 2.3795940 E3 X1 74.3307120 E-3

cz2 27.9242860 X2 25.4226000 E-6

c3 -27.3828380 X3 =2.1752340 E-6
X4 =71.7971840 E-6
X5 20.1043360

Check calibration expiry Reqguest calibration guote

You can edit the coefficients. As soon as you make a change and move to another cell, a new calibration date will be
displayed. Also, Store calibration and Revert calibration buttons will become active.

Configuration | Information | Calibration Parameters

Parameter  3: Pressure e

Sensor serial number: N122080

Label Value Label Value
X0 10.1991000
1l 2.3795940 E3 %1 74.3307120 E-3
cz2 27.9242860 X2 25.4226000 E-6
c3 -27.3828380 X3 =-2.1752340 E-6
X4 =71.7971840 E=6
X5 20.1043360
Store calibration Revert calibration Check calibration expiry Request calibration quote

Use Store calibration to save the new values.

A Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost
once your session is closed.

Use Revert calibration to recover to the original coefficients if you have not already saved your changes to the
instrument.

& You cannot use Revert calibration after clicking Store calibration. Once the coefficients are saved to the
instrument, you will need to restore old values manually and save them again.
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9 Parameters

The Parameters tab displays all the parameters the RBR instrument may need for calculating derived channels.

If your instrument can measure a parameter, it will use the measured value. Otherwise, you can enter the necessary
values manually, and they will take effect immediately.

For example, you always need atmospheric pressure and water density for derivation of depth. Default values in Ruskin
correspond to sea level and sea water. Therefore, it is especially important to adjust these parameters when working at
high altitudes in fresh water.

Enter atmospheric pressure (in dbar) and water density (in g/cm3) manually in the table under the Parameter tab. If not
entered, default values of 10.1325dbar and 1.0281g/cm3 will be used.

Configuration | Information | Calibration Parameters

Temperature (*C) 0.0
Pressure (dbar) 10.1325
Atmospheric pressure (dbar) | 9.7700

Density (g/cm?) 1.0000

*Parameters take effect immediately
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10 Preferences

On your Mac, access Preferences from the Ruskin dropdown menu in the top toolbar.

® Ruskin File Instruments Help
i } -
® About Ruskin
-&? I I IEIH ences... “ N
™ Services »
581
g Hide Ruskin
i Hide Others
Show All
Quit Ruskin

On your Windows PC, use the Options dropdown menu to set up your preferences.

File Instruments Options  Help

i Mavigator Preferences... = H

Factory-set global defaults require no changes in most situations. However, as you learn more about what Ruskin can
do, you may want to change some of these settings to better suit your requirements. The global preferences include:

« Derived channels (applies to some legacy instruments)

« Facility (authorised users only, requires login)

+ General (download locations and options, sampling and calibration controls, export options)
« Plotting (channel visibility and channel colours)

10.1 Derived channels

& The Derived channels settings are intended for XR(X),1060, 2050, and 1050 RBR legacy data loggers. They do

not apply to newer generations. They do not apply to any RBRcoda or RBRcoda® instruments.

Newer generations calculate all possible derived channels for that specific instrument.

Use the Parameters tab in the instrument Properties window to set up initial parameters for calculating
derived channels.

For downloaded files, use the Parameters tab in the dataset Properties window.

The Derived Channels section of the Preferences dialog box has four tabs: Depth, Conductivity - Salinity, Dissolved
02, and No sensor values, where you can choose additional channels derived from measured channels.

Derived channels calculated by the instrument as well as those calculated by Ruskin are automatically added to the
default channel list in both the live Plot view and the static dataset.
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Depth

If your instrument has a pressure channel, you can use its measurements to derive a depth channel. The data calculated
for this derived channel appear along with measured channels in the Plot view and in datasets.

[ el Preferences
Derived Channels fe=R3 g
Enable and configure derived channels
g‘lf":;t";l This feature intended for XR(X),1060, 2050, and 1050 RBR data loggers. It does not apply to newer generations.
Plotting Depth = Conductivity - Salinity ~ Dissolved 02 Mo sensor values

Enable Depth Channel
Any logger with a pressure channel
Atmospheric Pressure (dbar) 10.1325
© Simplified derivation: depth[m]=(pres-atmos)[dbar]{(density*0.980665)
Density (gfcm®) 1.0281
Seawater derivation: UNESCO Tech Paper in Marine Science No. 44

Latitude (degrees) 0.0

Restore Defaults Apply

Cancel Apply and Close

1. Select the Enable Depth Channel checkbox.

& Fornewer generation instruments, all derived channels are calculated regardless of the checkbox
status.

2. Inthe Atmospheric Pressure box, type the value in dbar or use the default value. This value corrects the
pressure measurements during the depth calculation.

& The default Atmospheric Pressure value is 10.1325. Adjust this value manually to represent a different
altitude.

3. Select either the Simplified calculation or Seawater calculation.

& Ruskin can calculate depth based on the simplified calculation or the UNESCO seawater calculation.
The instrument always calculates depth using the simplified calculation.
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a. Touse the simplified calculation, type the actual water density, or use the default value. Note that for
freshwater, the density should be set to 1.0.

b. To use the UNESCO seawater calculation, specify the latitude of the data collection in degrees and
minutes.

& The Conductivity - Salinity tab is only relevant for legacy standard instruments with a conductivity sensor. It
does not apply to legacy compact instruments.

Dissolved 02

You can derive a dissolved oxygen channel that measures oxygen saturation as a percentage.

® & Preferences

Derived Channels (=1 g

Derived Channels Enable and configure derived channels

Facmtvl This feature intended for XR(X),1060, 2050, and 1050 RBR data loggers. It does not apply to newer generations.
General
Plotting Depth Conductivity - Salinity Dissolved 02 Mo sensor values

Enable Dissolved Oxygen Channel
Any logger using an Oxyguard DO sensor
Derive concentration using the Weiss equation

Use the following unit  maj/L

Any logger using an Optode DO sensor
Derive concentration using the Weiss eguation
Use the following unit  mgj/L (2]

Derive saturation using the Garcia and Gordon equation (if sensor reports concentration)

Any logger using a Rinko DO sensor
Derive concentration using the Weiss equation

Use the following unit  majL (2]

Restore Defauits Apply

Cancel Apply and Close

1. Click the Dissolved O, tab and select the Enable Dissolved Oxygen Channel checkbox.

& Fornewer generation instruments, all derived channels are calculated regardless of the checkbox
status.

2. Ifyour instruments use the Oxyguard DO or RINKO DO sensor, select the Derive concentration using the Weiss
equation checkbox and the output unit: pMol/L, mg/L, or mL/L.
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A The Weiss equation requires values for temperature and salinity. If your instrument does not measure
them, you can specify standard values on the No sensor values tab.

3. If yourinstruments use the Aanderaa Optode DO sensor to measure oxygen saturation, select the Derive
concentration using the Weiss equation checkbox and the output unit: mg/L or mL/L.

4. If any of your instruments use the Aanderaa Optode DO sensor to measure oxygen concentration, select the
Calculate saturation using the Garcia and Gordon equation checkbox.

& The Garcia and Gordon equation requires values for temperature and salinity. If your instrument does
not measure them, you can specify standard values on the No sensor values tab.

No sensor values

Enter salinity, pressure, and temperature values used to calculate the derived channels when a sensor is not available.

Derived Channels O g

Derived Channels Enable and configure derived channels

Famlltyl This feature intended for XR(X),1060, 2050, and 1050 RBR data loggers. It does not apply to newer generations.
Genera
Plotting Depth Conductivity - Salinity Dissolved 02 Mo sensor values

Derivations of Dissolved Oxygen and Density

Salinity [PSU) to be used when no eonductivity sensor is present 35.0

Derivations of Salinity and Conductivity Correction

Hydrostatic pressure (dbar) to be used when no pressure sensor is present 0.0

Derivations of Dissolved Oxygen

Temperature (°C) to be used when no temperature sensor is present 0.0
Restore Defaults Apply
Cancel Apply and Close

A fyou suspect that the derived channel value is incorrect, check to make sure that the No sensor values
entries match the deployment environment.
For example, if a dissolved oxygen saturation measurement is made in a lake at 8°C but the No sensor values
salinity is 35 and the temperature is 15°C, concentration reported will be incorrect.
Adjust the No sensor values entries and recompute.
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10.2 General

Use the General preference page to set up file locations, language, download options, sampling and calibration
controls, and export options.

@ @ Preferences

General i g

Derived Channels

Facility
File location

Plotting Directory for RSK downloads JUsersjichapman/Downloads Browse,
Directory for realtime RSK files [Usersfichapman Browsa.
Directory for log files JUsersfichapman Browse.

*Takes effect on the next file stored
Language selection

English e (restart required)

Download options

Enable download schedule Ul
Automatically open RSK files produced using the auto download feature

Automatically append new dewnloads to existing RSK file with matching deployment

Sampling contral

Enable advanced sampling controls

Calibration control

Enable advanced calibration controls

Export options

Enable raw data export

Restore Defaults Apply

Cancel Apply and Close

@ You can click Apply to save your changes without closing the dialogue box.

File location
You can control where RSK files, realtime RSK file, and log files are stored by default.

Specify these locations before downloading any data by typing in a directory name or by browsing.

File location

Directory for RSK downloads JUsersfjchapman/Downloads Browse...
Directory for realtime RSK files  /Usersfijchapman Browse...
Directory for log files JUsersfichapman Browse...
*Takes effect on the next file stored
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RSK files are the datasets obtained from your instrument.

Realtime RSK files are generated when a connected instrument is streaming or when you enable fetching mode on the
instrument.

Log files are generated by Ruskin and help when diagnosing issues. These files are automatically attached to issues
generated using the Comment on Ruskin feature.

& RBRrecommends storing your datasets on a local drive rather than a network storage drive. Cloud storage
options such as GoogleDrive and Dropbox may extend download times.

You can change where future files are stored by default at any time. When done, click Apply or Apply and close. The
changes will take effect immediately.

Language selection

Ruskin is available in six languages: English, French, Spanish, Simplified Chinese, Korean, and Japanese.

Language selection

| (restart required)
Frais

Ezpafiol

X schedule Ui

I

Haig

in RSK files produced using the auto download feature

__+end new downloads to existing RSK file with matching deployment

Select your language from the dropdown menu and click Apply or Apply and close. Ruskin will need to restart for the
changes to take effect.

Download options

Select the appropriate checkboxes to change your download preferences.

Download cptions
v Enable download schedule Ul
Automatically open RSK files produced using the auto download feature

v Automatically append new downloads to existing RSK file with matching deployment

& The Enable download schedule Ul checkbox is only for legacy instruments.

When done, click Apply or Apply and close. The changes will take effect immediately.
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Sampling control

Select the checkbox to enable advanced controls when setting up your sampling options.

Sampling control

Enable advanced sampling controls

With simple controls, you will select Speed, Duration, and Interval from pre-defined options in three dropdown
menus. When advanced controls are enabled, you will be able to enter these parameters manually and achieve a more
precise setting.

When done, click Apply or Apply and close. The changes will take effectimmediately.

Calibration control

Select the checkbox to enable advanced controls when setting up your calibration options.

Calibration control

Enable advanced calibration controls

With simple controls, you will be able to view and edit only the main coefficients (C). When advanced controls are
enabled, you will be able to view and edit all main and dependent calibration coefficients (C, X) for any channel.

When done, click Apply or Apply and close. The changes will take effect immediately.

Export options

Select the checkbox to enable raw data export. Use this option for downloading your RSK file when storage space is
limited or expensive. The dataset will be exported in the most compact raw binary format.

Export options

Enable raw data export

When done, click Apply or Apply and close. The changes will take effect immediately.

10.3 Plotting

Adjust default settings for the graphical display in the Plot view. Manage selections in Channel visibility and Channel
colours, and apply them globally.

@ Youcan click Apply to save your changes without closing the dialogue box.
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Channel visibility

The Channel visibility tab displays many options to hide or show specific information.

Preferences

Plotting

Derived Channels
Facility
General

Manage default plotting behavior

Channel visibility

Use single axis for similar channels
Show dataset events by default
Show dataset errors by default

By default, hide all measured channels

Hide conductivity channels
Hide temperature channels
Hide pressure channels
Hide dissolved 02 channels
Hide distance channels
Hide fluorometery channels
Hide pH channels

Hide PAR channels

By default, hide all derived channels

Hide salinity channels

Hide depth channels

Hide pressure channels

Hide specific conductivity channels
Hide speed of sound channels
Hide density anomaly channels

Channel colours

By default, hide any measured channel underlying a simple derived channel

Automatically save live data to a file (Legacy instruments)

Hide ORP channels
Hide transmittance channels
Hide turbidity channels
Hide voltage channels
Hide RBRquartz® period channels

Hide distance channels

Hide dissclved 02 channels

Hide RBRquartz® pressure channels
Hide RBRquartz® temperature channels

Restore Defaults Apply

Cancel

Apply and Close

000

Opt for displaying errors and events for a more informative graph, or hide them for a cleaner view.

Select the By default, hide all measured channels checkbox to display only derived channels.

Select the By default, hide all derived channels checkbox to display only measured channels.

Otherwise, pick and choose channels to display or hide.

When done, click Apply or Apply and close. The changes will take effectimmediately.

& You can override visibility preferences in the Plot view for any particular graphical display.
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Channel colours

The Channel colours tab allows you to choose a different colour for each channel that is shown for information
currently running in Plot view, or from an opened dataset. Select from the list of pre-defined options or create your own
colour.

Preferences

000

Plotting fe=R3

Derived Channels
Facility

General Channel visibility Channel colours
Plotting == ;

Manage default plotting behavior

CHANNEL_1
||

™
CHANNEL_2 ) = B i
CHANNEL_3 o == =
CHANNEL_4
CHANNEL_6
CHANNEL_7
CHANNEL_8

CHANNEL
CHANNEL_13
CHANNEL_14
CHANNEL_15
CHANNEL_16

Channel colours can be previewed on the active plot. l ] -

Restore Defaults Apply

Cancel Apply and Close

When done, click Apply or Apply and close. The changes will take effectimmediately.
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11 RSKfiles

The RSK file is a single file database based on SQLite that allows us to have large files with high-speed access to any part
of the dataset. RSK files have different types and versions, which reflect historical changes to the underlying dataset
structure. To upgrade the version of an older RSK file, go to File info tab.

RBR provides open-source RSKtools toolboxes for both Matlab (RSKtools) and Python (pyRSKtools) to read, post-
process, visualise, and export RSK files.

RSK files can be exported to Excel, OceanDataView®, or text files.

RSK files contain raw measurement data, firmware and software versions, dates and times, sampling settings, power
settings, measured and derived parameters, errors and events, other diagnostic information.
» Datasets in the Desktop storage format allow changes to calibration coefficients. GPS mapping for full RSK
files relies on manually added location points.
This file format is available for RBR standard and compact instruments.
+ Datasets in the Mobile storage format support charting and GPS tracking. They do not allow changes to
calibration coefficients.
This file format is only available for RBR standard instruments.
«+ For datasets obtained via streaming or fetching, the RSK format is Realtime. Their names contain the "realtime"
label.
This file format is available for RBR standard instruments and RBRcoda® when in streaming mode, and for all
instruments when fetching.

To identify the type of the RSK file, go to the File info tab.

File naming convention for datasets obtained during deployments

By default, RSK file names are composed of the following information:

« Theinstrument serial number: six digits
+ The date of the download (YYYY-MM-DD): eight digits
+ The time of the download (HH-MM in the 24-hour format): four digits

For example, the file named 209681_20220531_1306.rsk contains the dataset for an instrument with a serial number of
209681; the data was downloaded on May 31, 2022 at 13:06 (01:06pm), local time.

The RSK files obtained during a deployment are saved on your instrument. Download them to your computer before
starting a new deployment. Go to Preferences > General to change your default location for RSK downloads.

& Thefile extension is .rsk; it indicates the Ruskin file format and must not be edited. If you change it, your new
file extension will become part of the dataset name, and the .rsk extension will be appended.
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12 Datasets

Datasets are RSK files generated by Ruskin and have an .rsk extension. After downloading your datasets, you can view
and analyse your data using the options below.

Go to the File dropdown menu to open or close a dataset, export your data, and see the list of available datasets.

The Datasets context menu in the Navigator windows duplicates some of these options for convenience.

® Ruskin File Instruments Help

(r -
| NN Open dataset
-ﬁ- Navigatﬂ; “\1 :

v g Instrumen Export

O RBRconcel
i MLM 1: 209681_20220414_1600.rsk

£ Datasets

®0

.

t-ﬁ!— Navigatur.'

—=

b i Instruments
ORBRconcerto?® 209681
i MLM
A gDatasets
' 1 203672...1240
[5h 209681... 1600
|75 209681...1106 Export

Hacaol

Close dataset

Explore the contents of your datasets in the Properties window.

When a dataset on the list is selected, the Properties window displays four tabs with information related to this

dataset.

Use these tabs to analyse your data, check the calibration certificates, and verify your parameters.
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12.1 Open dataset

Open any stored dataset from the File menu in the top toolbar or from the Datasets menu in the Navigator view.

Steps
1. Click File > Open dataset.

# Ruskin File Instruments Help

}- e
[ NN Open dataset
s Navigatur.\\ll

hd i Instrumen Export
D RBRconcel

£ Datasets

%0

i MLIM 1: 209681_20220414_1600.rsk

om

Alternatively, right-click Datasets in the Navigator view and select Open dataset.

o3 Navigata-r-'

= H

% i Instruments
RBRconcerto?® 209681
e MLM

~ Datasets

[ 209681...1106

2. Abrowsing window will appear. Double-click the .rsk file you want to view, or select the file and click Open.

Favorites

= v & Desktop
% Dropbox...
£ General = Name
@ Recents 203762_20220622_1114_realtime.rsk
& RooRcatl., I 203672_20220517.1240.rsk
209681_20220531_1106.rsk
B jchapman
= Desktop

[ Documents
(@ Downloads
lia) Pictures
iCloud

¢ iCloud Dri...
9 Shared

Locations

[ storag.. & New Folder Options

All supported files

Kind

242 KB Document

Document

319 KE Document

-
w

Date Added

Jul 22, 2022 at 9:4
Jun 13, 2022 at 1:4!
Jun 13, 2022 at 1:4

Cancel
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3. The name of the dataset appears and is highlighted automatically in the Navigator view. The Properties view
changes to the dataset, with four tabs: Analysis, Overview, Channels, and File info.

-+ Navigator = O || = 203672_20220517_1240.rsk 3

N i A Analysi;"._ Overview | Channels.i File info |
ORBRconcerto? 209681 : 1 i
o MLM

b 5 Datasets

Bt 203672...1240 i
|m) 209681...1600 Sample 1
\m$ 209681...1106 Time 2022-05-17 16:40:23.0002

Display statistics

Number of samples

Channel Value Unit
Pressure 9.9299650 dbar
Sea pressure -0.2025347 dbar
Depth -0.2008831 m
Temperature 21.9603271 w0
4. The data in the file will automatically appear in the Plot view.
il RBRconcerto® 209681 | il 203672_20220517_1240.rsk 53 . jill 209681_20220414_1600.rsk | i 209681_20220531_1106.rsk =0
: = - S RA e d a R W E-Hoe
-0.210 Uil 10.020
23.000 i -0.120 10,010
-0.200
32.500 o) s 10.000
g 'E 01401 g 5op
£ 2000 = 151D =
g E s 01015 g
2 e S
gasmB 05 |3 m
E (=l =t <UD § 9.960
e e o § 0,180 1~ 9.950
-0.140
20,500 =k 5.840
-0.130
v 9.930
20.000 -0.120
“ 17:00 18:00 19:00 20:00 21:00 22:00 23:00 00:00 01:00 0z2:00
Time
P
E T~ —

@ Toclose adataset, go to File > Close dataset. Alternatively, right-click the dataset name in the Navigator view
and select Close dataset.

Alternatively, simply close its Plot tab by clicking the X. The dataset will disappear from the list.
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12.2 Export

Use the Export option to share your data with others or analyse your data using other software. Datasets can be read
directly in Matlab with our toolkit RSKtools, or exported to Excel, OceanDataView?®, or text files.

Steps
1. File menu > Export, then hover to open a set of submenus.

_ Instruments  Help

Open dataset
Close dataset

Annotations
[ Microsoft Excel (*xlIsx)
(;f netCDF ("nc)
§ netCDF profiles (%nc)
=) Text (*.zip)
|4 OceanDataView spreadsheet (%.odv)
Raw binary (*bin)

Export
1: 209718_20220616_1210.rsk

2: 209718_20220616_1209_realtime.rsk
3:203672_20220517_1240.rsk

4: 209681_20220531_1106.rsk

5: 209681_20220414_1600.rsk

6: AUTO_209681_20220613_1311.rsk

I Full Profiles
ﬁ Downcasts
@ Upcests

£ -

or right-click the dataset in the Navigator window, then hover to open a set of submenus.

e = )
4% Navigator =] [EI 203672_20220517_1240.rsk s@\
L — g
f—g :
glnstruments Analysis Ovemiew] Channels} File info]
MLM =
v gDatasets Cursor
| B 203672...124
B 209661... 160 L o= detaret : _ e
[ 209681...11¢  Export > | Annotations 2| I Comment regions

[ 209718...tim¢  Reset chart view 07 Microsoft Excel (*xlsx) i Full Profiles

[@)209718...121v

'@ ois © netCOF (*nc) @ Downcasts
b & netCOF profiles (*nc) I Upcasts
B Text (~.zip)
| E OceanDataView spreadsheet (“odv) Avg Std Unit
Pr Bl Raw binary (*bin) 706 0.0013409  dbar
Sea preoeue L s 1 0.0013409  dbar
Depth -0.1987538 -0.1875052 0.0013300 m

2. Select the appropriate export format (Microsoft Excel, netCDF/netCDF profiles, Text, OceanDataView
spreadsheet, or Raw binary).

If exporting annotations, select the category: Full profiles, Downcasts, or Upcasts.

Specify a location and a name for the data file.

5. Click Save.

Hw
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12.3 Analysis

Select a dataset in the Navigator view. The Properties view will change to dataset properties, with four tabs: Analysis,
Overview, Channels, and File Info.

The Analysis tab has two options: Cursor and Calibration.

Analysis “. Overview  Channels | File info |
Cursor  Calibration
Sample 1

Time 2022-05-17 16:40:23.000Z

Display statistics

Number of samples

Channel Value Linit
Pressure 9.9299650 dbar
Sea pressure -0.2025347  dbar
Depth -0.2008831 m
Temperature 21.9603271 o e

The Cursor view contains statistical information about deployment, as well as information about the dataset channels
and their values.
Move the black cursor ("double lollipop") in the Plot window to display parameter values for each sample selected.

Every time you move the black cursor, going form sample to sample, the table above the plot will display the
information for this particular sample.
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Sample 1833209

Analysis . Overview  Channels | File info !

Time

Mumber of samples

Display statistics

Channeal Valuo Unit
Pressure 59.9480430 dbar
Sea pressure -0.1864567  dbar
Depth -0.1849362 m
Temparatura 22.73181156 G

Cursor

2022-05-17 19:51:25.625Z

134

195

13

1wy

198

200

201

202

203

Press ure (dbar)

1|jill 203672_20220617_1240.rsk 32 . jii 209718_20220616_1209_realtime.r
i Location i2) [v! [ @@ 2z ) 2
9.939 <
0,998 |

0.937 -

0036

=dm

" . A w

| iRy @ @ GG @ B Ees

€ CUursor

14:51:00 19:52:00 19:52:30

Select Display statistics checkbox to determine the average value and standard deviation over a range of samples.
Change the number of samples to average using the up and down arrows.

The table will display the averaging data. The averaging interval will be highlighted in the plot.
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On the Calibration page, you can recalculate your coefficients for the DO and Tu channels. See User calibration.

RBR#0006106revK

Analysis Over\rlaw] Channels  File info |

Curser
sample 183210 - 183309
Time 2022-05-17 19:51:19.4387 - 2022-06-17 19:51:25.6257
Display statistics
Mumber of samples 100 o
Channel Value Ay Std Unit
Pressure 9.9460430 £.9459233 0.00142858  dbar
Sea pressure -0.1864567 -0.1B65764 00014285  dbar
Depth -0.1849362 -0,1850549 0.0014168 m
Temperature 227318116 22.7318048 0.0004149 '

j 203672_20220617_1240.rsk 3 ﬁ 209718_20220616_1 259Jeafhime.rsk.§
Location (2] | v “* 22 op w o A Lo C M‘E{. :l"k'l';é

8,658 4

< Cursor

2.937 4

0,950

L H ; . - o . ' ' v +
19:50:40 10:50:50 19:51:00 19:50:10 19590 19:51:30 105140 19:51:50 19:52:00 19:52:10 19:52:20
Time

Fd
Averaging interval
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12.4 Overview

Use the Overview tab to view general information for each dataset, such as instrument details and deployment events.

Analysis | Overview ._Channels | File info |
File location

JUsersfjchapman/Downloads/209718_20220616_1209_realtime.rsk

Logger Deployment Continucus
Model: RBRduet* Mode fetching Period: MNA
Serial: 209718 Time offset: UTC-4:00
Firmware: 1.058 Time drift: Oms
Deployment start time:  2000-01-01 00:00:00
Markers
First sample time: 1999-12-30 20:00:00 Gate
Errors: 0 !
3 Last sample time: 1898-12-30 20:00:00 Gate: none
Warnings: 0 ) .
- First event time: 1999-12-31 20:00:00
Information: 0 ;
- Last event time: 1999-12-31 20000:00
Diagnostics:
J a Samples: 0
Comment

To make a note about this dataset, enter your comment in the field provided and click Save comment.

12.5 Channels

The Channels tab has three options: Information, Calibration, and Parameters.

Analysis | Overview | Channels File info |

Information Calibration Parameters

Measured channels

# Parameter Sensor Range
1 Pressure (dbar) RER nfa
4 Temperature (°C) Pressure correction nfa

Derived channels

# Parameter Notes
2 Seapressure (dbar) Removes atmospheric pressure
3  Depth (m) Simplified, using density parameter
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Information

The Information page displays two tables: Measured channels and Derived channels.

Measured channels include measured parameters with their units of measurement, the sensor manufacturer, and the
range setting (if applicable).

Measured channels

# Parameter Sensor Range
1 Pressure (dbar) RER nfa
4 Temperature (°C) Pressure correction nfa

Derived channels include all available derived parameters with their units of measurement and the methodology used
to calculate them.

Derived channels

# Parameter Motes
2 Sea pressure (dbar) Removes atmospheric pressure
3 Depth (m) Simplified, using density parameter

Calibration

The Calibration page displays the calibration coefficients and correction coefficients (as applicable) for each channel,
as well as the date and time of the last calibration. Select a sensor from the Parameter dropdown menu to display its
calibrations.

Analysis Overview |Channels File info

Information Calibration Parameters

Parameter W0 1 perature
Calibratiy 2 ressure Bz
4: Sea pressure

Label 5. pepth

(o S Seessin wE,
Cl =254.7562B00 E-6
c2 2.4126525 E-6
c3 -96.1401840 E-3

The main calibration coefficients are displayed as "C" values: C0, C1, C2(K). Dependent coefficients are displayed as "X"
values: X0, X1, X2, etc.

You can edit any of the coefficients in your dataset, regardless of the advanced calibration controls settings in
Preferences.

As soon as you make a change and move to another cell, a new calibration date will be displayed. Also, all three buttons
at the bottom of the page will become active.
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Analysis | Overview | Channels File info
Information  Calibration  Parameters

Parameter 1: Pressure (2]

Sensor serial number:

Label Value Label Value
co -3B.4045200 X0 10.1991000
cl 2.3795942 E3 X1 74.3307100 E=3
x2 25.4226000 E-6
c3 -27.3828370 X3 =2.1752342 E=6
x4 -71.7971850 E-6
X5 20.1043360
Store and recompute data Revert calibration Use deployment calibrations

Use Store and recompute data to recalculate the dataset. Use Revert calibration to recover the previous coefficients
and data if you have not already selected Store and recompute data.

To revert calibration and recalculation after it was stored, check the Use deployment calibrations checkbox. Click
Store and recompute data to save the reverted coefficients.

Store and recompute data Revert calibration Use deployment calibrations

Parameters

The Parameters tab displays parameters necessary to calculate derived channels and the method used for calculation.
You can edit these parameters to change the derived channel calculation. As soon as you make a change, the
two buttons at the bottom of the page will become active.

Analysis Overview | Channels File info

Information  Calibration  Parameters

© simplified depth derivation
Seawater depth derivation

Atmospheric pressure (dbar) 9.7700

Density (a/cm?) 1.0000

Latitude [degrees) 0.0

Speed of sound type UNESCO e

Specific conductivity coefficient 0.0191

Oxygen concentration units ma/L Q
Salinity 35.0
Absolute pressure (dbar) 10.1325
Temperature (*C) 0.0
Average sound speed (mys) 1550.744

Update and recompute Revert settings

Click Update and recompute to recalculate the data and display new values.
Use Revert settings to recover the previous coefficients and data if you have not already selected Update and
recompute.
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12.6 Fileinfo

The File info page displays the dataset name and download location, Ruskin version used when it was obtained, file
structure, and size.

The Structure label reflects the RSK file format, which can be Desktop, Mobile, or Realtime.

Ruskin checks the dataset for compatibility with the newest version of Ruskin software. If the file requires updating, a
warning message and an Update button will be displayed.

Analysis | Overview | Channels |File info

About

File name: [Usersfamoore/Downloads/Example Ruskin File.rsk
Version: 1.12.2

Structure: Desktop

Size: 675 KB

Update

A new version of the RSK file format is available
The anticipated update duration is: 00:02

Update

Click Update. It may take several minutes for it to complete. RBR strongly recommends that all datasets are updated
and meet compatibility requirements.

Update

A new version of the RSK file format is available
The anticipated update duration is: 00:02

Update time remaining: 00:00:03
S

Cancel

© Failing to update your dataset may result in odd graphical displays and incorrect reporting of the sample
values.
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13 Plot window

Use the Plot window to view graphical displays of your datasets or live data. When viewing live data, the instrument
must be attached.

Each channel appears as a different colour in the plot. These colours are specified under Preferences > Plotting and can
be changed only there.

il 66015 North Atlantic.rsk 5 Profite (7 [ 1 I RA @@ @ QA KB-E-a= 8

Move the black "double lollipop" cursor from one sample to the next to display parameter values for each sample
selected. For the datasets, these values will appear in the Properties window above (see Analysis). For live data, they
will be on the side of the plot.

The graphical display for each dataset or instrument will be in its own tab. The dataset file name or the instrument
model and serial number will appear at the top of the tab. Simulated instruments will have "sim" in front of their name.

M RBRconcerto® 209681 | i 203672_20220517_1240.rsk 5% . ji§ SimRBRduet® 905077 i simRBRcoda® 906843

Atoolbar at the top right of the Plot window contains various buttons to help you customise, explore, and export the
graphical display. The buttons selection changes depending on what is displayed in the tab. Hover over a button to
display its name and function.

- | - FrNA e Qe B-Hoe HE-0»

A downsampled representation of the dataset appears in the thumbnail view, along with an indicator of the current
plotted time range.

L
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Position the indicator by clicking on the thumbnail view and dragging the indicator. Resize the indicator by dragging the
edges left and right. It will zoom the main plot along the time domain to match the new indicator size.

Temperature (°C)
Temperature (°C)

Time.

123300 123330 123400 123430 123500 123530 123600 123630 123700 123730 123800 123830 123900 123930 1240:00 12:40:30
Time
|

==

& Thethumbnail view always shows the plot-by-time data, even if the plot is switched to the plot-by-depth
mode.

When you close and re-open a dataset, it will retain your latest settings (channel visibility, zoom, plot style (plot-by-time
or plot-by-depth), annotation selection, and display style (lines or markers).

Double-click anywhere on the main plot to return to the full-chart view.

Go to Appearance controls to change your selection of lines and markers.

13.1 Dataset plot toolbar

Use the plot toolbar to adjust the display of an open dataset.

Cast
detection Appearance
l Zoom controls controls
) - i a-eea aepeBE o
Annotation T T T
controls Event Export GPS
visibility plot map
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13.1.1 Annotation controls

Annotations are information messages added either by users or by the instrument.

Create annotation

Filter Index l
Protile (557) vi|ide €3/ 557 | B <~

1

Navigation buttons

Annotation types

Annotation types are divided in two categories: profiling (Profile, Downcast, or Upcast) or non-profiling (Comment,
Exclusion, Location, or Calibration). Use annotation controls to manage this information and to navigate the plot.

Type Function

Profile, Downcast, Upcast Identify profiling

Comment Add a note to your data

Exclusion Remove a non-representative interval from analysis

Location Add in latitude/longitude coordinates for RSK files to track locations of
data logging

Calibration Calibrate the ODO sensor (available only for RBR standard instruments

using the RBRcoda® T.0DO as an integrated sensor)

Open the Filter dropdown menu to select the annotation type to display. The number of annotations for each type will
be indicated.

Locatlon (1) r

Profile (557)
Downcast (557)

Select an annotation type. The plot will centre on the first item in the selected category. For example, when you select
Profile, the plot will move to the first profile.
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If you switch the filter to another annotation type within the same category (for example, Profile to Upcast), the plot
will not change. If you switch to a type from another category (for example, from Profile to Comment), the plot will
move to the first annotation in the new category (for example, to the first comment).

= €@ 552 | 557 B B

Use the Navigation buttons to navigate between items within the selected category.

& The navigation buttons will be activated if there is more than one item in the selected annotation type.
Otherwise, the plot will centre on the only item available.

Navigation controls

+ Move from one annotation to another by clicking the left and right arrows.

« Jump all the way to the beginning or end of the list by using the end-left and end-right arrows.
« Alternatively, manually enter the number in the Index field to go to that particular annotation.
« Double-click an annotation to centre and zoom in the plot at that particular area.

W 203672_20220517_1240.rsk = W 203672_20220517_1240.rsk 5 =0

comment (2) [v] |48 48 2 4 2 GrRA 2@ 3P & BEH-a® comment (2) [v] [éa @@ 2 2 FrNA @@ Q@ B EHoae

20.400] 9.984
2082

20.3 9.980 COMMENT 2 48 T AOOX # |
o e Gomment2 g HI’
20300 Desails i \r

nosiranzsa  zzosrzavizs GRI

2220517212521 20220517 230125

20,250

iz MWW".NJJIWNMIJzw""

e | I‘
200501 g 0gs [N

g
Ure (dban

Temperature (°C)

Temperature (*C)

2100 21140 2220 21300 2340 00:20 o100 o01:40 02:20 2130 2140 2150 22100 22110 22220 22130 2240
Time

2250 2300

Time

@ Double-click anywhere on the main plot to return to the full-chart view.

Click the Create annotation button L™"_"| to enter a new comment, location, profile, or exclusion.

Steps to create an annotation
1. Select the type of annotation to create, for example, Comment.

Gow R A Gy
Comment

Location

Profile

Exclusion

The cursor in the Plot window will become a two-way arrow
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2. Click on the main plot to identify a single point to comment, or click and drag the cursor left or right to select an
interval. When you release the click, an editable tooltip will open.

COMMENT 1 er X
Titla
Datails

2014-07-15 14:56:37 2014-07-15 14:58:37
W

| S

The tooltip controls include left and right arrows @ , Delete EI, Save , and Close E

3. Enter the necessary information into the fields and save by pressing Enter on your keyboard or by clicking Save

on the tooltip. Your new comment will appear in the dropdown list.

Comment (1) r

Locatlon (1)
Profile (557)
Downcast (557)
Unract (5571

Clicking Close E or pressing Esc on the keyboard will close the tooltip without saving.

A Edit at least one detail in the tooltip before saving. Otherwise, the annotation will be deleted when
deselected. Moving or resizing the annotation counts as editing and saving.

]

4. Click the arrows on the tooltip to move to the next annotation within the same category.

5. Click Delete |j on the tooltip to delete the annotation.
A warning message will appear.

) Ruskin

| Are you sure you want to delete this annotation?

Click Delete to proceed. This action cannot be undone.
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13.1.2 Cast detection

Ruskin automatically enables profile detection on instruments when a deployment is enabled. There are several criteria
for enabling this feature.

+ Theinstrument must support the castdetection setting

« Theinstrument must have a pressure sensor

+ The deployment must be configured for | fast sampling (2Hz and up)

+ The deployment mode must be configured as either continuous or directional

It is possible to recalculate the casts in a dataset using the cast detection feature in the Plot view.

Click the Cast detection button LA to run a cast detection algorithm based on depth and conductivity to
automatically generate profiles and casts. A warning message will appear.

@ Cast Detection - Are you sure?

Warning!

The cast detection operation will replace all instrument-generated profiles/casts, even those that have
been edited, and may take a long time to run.

Are you sure you want to proceed?

concel (TN

If you proceed, Ruskin will find peaks, collect events, and overwrite profiles recorded by the instrument.

@ Double-click anywhere on the main plot to return to the full-chart view.

13.1.3 Eventvisibility

Click the Event visibility button to turn on and off the visibility of the various levels of events: Error, Warning,
Information, and Diagnostic. Its colour will reflect the highest level of event severity reported.

A GG @ @ O O Luw @G & @ gl | Ay dragy @ & Gl
m ! + /Ay Warning (1)
~ A\ Information (2) + /% Information (1)
+ £\ Diagnostic (23) /b Diagnostic (2228) - :
| i e i
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13.1.4 Zoom controls

Default scaling of the plot is based on the minimum and maximum values sampled for each channel.

4.i 3 A=y
Use the Zoom in horizontally = and Zoom out horizontally = buttons to increase or decrease the the time
range displayed.
In the same way, use the Zoom in vertically and Zoom out vertically buttons to increase or decrease the

resolution of the data displayed. Even more conveniently, hover the cursor and scroll your mouse wheel up and down
to change the scale. Alternatively, hold Shift + left click and drag where you want to zoom in or out.

This function may be helpful when there are erroneously high or low values that make the real data appear incorrect.

-- Cr A wod e @ Gl 6 BrEro @ = = - - N =
o = ! RA- e aq e e oy o = FrRAr g waan & BEHoV

17:00 18:00 19:00 20:00 21:00 22:00 23:00 00:00 01:00 02:00
Tim,

I 1700 18:00 19:00 20:00 21:00 22:00 23:00 00:00 0100 0200

Tirny

Hold Ctrl + left click and move your mouse left and right to pan your chart horizontally.
Click a value on the vertical axis and move your mouse up and down to pan your chart vertically to centre as desired.

|
45.000 15.000 f ‘ ‘ | In | ‘ ( | 1' | 1 | ‘
40.000 10,000
35.000 5.000
30.000 o
G 25.000 r O -s.000
— o
g o000 ¥ 10000
3 =1 .
= =
o el = -15.000
i (=8
ﬁEJ 10.000 E -20.000
= =
5.000 _35.000
0 -30.000
—5.000 -35.000
-10.000 -40.000
12:32:30 12:33:00 12:33:30 12:34:00 12:32:30 12:33:00 12:33:30 12:34:00

Click Reset zoom to maximum bounds = or double-click anywhere on the chart to restore the original
appearance.

. el . o
Use the Toggle auto-ranging button to turn on and off the auto-ranging of the channel axes. Disabling the auto-

ranging of the axis can be useful for looking at trends in data.

@ Double-click anywhere on the main plot to return to the full-chart view.
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13.1.5 Export plot

n

¥

Click the Export plot button

and select file name and location to save the current view of the main plot to a PDF

or PNG file. The exported file will contain the graph only and retain all the changes to display active at the moment of
export: zoom, lines and markers, visible events and annotations, and plotting by depth or time.

18- E

T

&

581_20220613_1311 with markers.pc

here: [ jchapman v L -
PDF File 7
(] n ‘,ﬂlo‘gnn
RN L
Taloossovvestd
- . =
X L
L e = LA .
P = . e o .'lll‘!:
a = i ‘Ix . [
o v *res . . v . .
- 3 = L3 " =
L4
» L
L

v

13:11:10 13:11:15 13:11:20 13:11:25

13.1.6 Appearance controls

Select your data rendering type from the Change line type dropdown menu : Lines, Markers, or Lines and

markers.

N e @ &g &l T
ml v Lines
Markers

Lines and markers

01:37:15 01:37:16 01:37:17 01:37:18 0L:37:

P A @@ @ &G ) @
Lines E

MNAr @G & Al & B

Lines

Lines and markers

01:37:15 01:37:16 01:37:17 01:37:18 0137

Markers

it

Wl |

01:37:15 01:37:16 01:37:17 01:37:18 01:37:

@ Ifnodata appears in the Plot view, try changing the rendering to Markers. Time spans that are larger than
expected will cause breaks between data points and lines will not be drawn connecting those points, whereas
markers draw at each individual point.

Use the Toggle channel visibility button

=
la=| ™

to open the dropdown menu with the list of available channels and

options. Check and uncheck channels to display as desired, or select groups to show and hide.
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Conductivity
Temperature
Pressure

Sea pressure

Depth

Salinity

Speed of sound
Specific conductivity

3

. + 11: Density anomaly

Show all channels Show >
Show measured channels !
. Hide ¥
— Show derived channels "
Show only > Show raw channels
Select Show raw channels to display measured data with no calibration equations applied.
|l 203672_2022051 [ﬁ 209681_2022053 [ﬁ AUTO_209681.20 8 - O
md -/ - F-RA @ a a -G & By [H-
. + 1: Raw Conductivity
ppzsl 034 g eppe s -« 2: Raw Temperature E. ]
f.oz4 { D389 1.000E— .« 3: Raw Pressure
0388
0.023 0.500E-3
E 0.022 g 0.3&?-_‘% o ks >
ﬁ 0.021 Eﬁ'im-g -0.5006-3 4- | - : Hide >
J e et |
& o020 Eo.ass 5 ~1.0DDE- . :
E s 0-334-: i l -/ Show raw channels _
ooig (o 038318 g T ; T
el g H H
0.016 e _3.000e-3 448 : : k
1?:11]:41] 13:10:50 13:11:00 13:11:10 13:11:20
Time

By default, the data are plotted by time. Use the Toggle depth plot button to switch to the plot-by-depth mode.
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The thumbnail view will continue to display the plot-by-time data.

() Ifthereis no depth channel, the plot will use the next pressure or pressure-derived channel starting from the
bottom of the channel list.

13.1.7 GPSmap

The Show GPS map button opens a pop-up window with the GPS map for the plot. Click on the map to display all
the GPS location annotations recorded in the dataset.

[ XN ) 203672_20220517_1240.rsk GPS Locations

GPS mapping for Desktop RSK files relies on manually added location points (see Annotation controls). All
location points you added using the Annotations feature are stored in the dataset file and can be displayed in
Ruskin via the mapping functionality.
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13.2 Live data plot toolbar

You can use the Plot window to view a live graphical display of your instrument sampling. All options described in the
Dataset plot toolbar section apply to live data display. Additionally, three live data buttons appear at the right end of
the toolbar: Side data panel, Live plot time range, and Fetch.

Cast
detection Appearance Live data
Zoom controls  controls controls
- - vdraee s a@a|elz-aoof [EHAw
Annotation controls T T T
Event Export GPS
visibility plot map

=

Click the Side data panel button L1 to toggle on and off the data panel to the right of the plot. It shows the file
location that will be used to capture samples, the number of samples collected, the values of the last received sample,
and the currently selected sample.

i - SN A @@ @ @ Qg e B-EH-o 0 |FHS-0 ‘- F-RA @@ @ @ Qe T-EH-00 HS5-0
Capturing to /Usersfjchapman/209681_20220620_1418
Sample # 26 (141 captured)
Time: 2022-06-20 14:19:15.000-04:00
# Value Last  Unit
1 -0.0005000 -0.0005000 mSfem
2 22.3110000 22.3376000 °C
3 10.1087000 10.1118000 dbar
4 0.3387000 0.3418000 dbar
5 0.3454000 0.3485000 m
1+ 0.0000000 0.0000000 PSU
7 1489.2417000 1488.3186000 m/s
8 -0.5230000 -0.5605000 pSfcm
14:19:10 14:19:15 14:18:55 14:19:00 14:19:05 14:19:10 14:19:15

Click the Live plot time range button to open a dropdown list of time span options.

For example, select 2 minutes to display the data in the thumbnail view and on the side panel by two-minute time
periods.
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o] = - = A - = - W= e 1 AR EREEE = =™
B e EE» -G NA e s AR e Ea e [HH
e i AT Capturing ta [Usersfichapman/209681_20220620_1418]
nan/i  All data '0_1418, Sample #: 26 (423 captured)
A Time: 2022-06-20 14:18:15.000-04:00
d: = # Value Last  Unit
b1g:¢ +' 2 minutes 1 -0.0005000 -0.0006000 mSfem
. 2 223110000  22.4030000 °C
5 minutes 3 10.1087000 10.1157000 dbar
. a 0.3387000 0.3457000 dbar
0.0 10 minutes 5 0.3454000 0.3526000 m
30 mi 6 0.0000000 0.0000000 PSU
22.4 minutes 7 1489.2417000 1489.5068000 m/s
10.1 1. hotr 8 -0.5230000 -0.6035000 pSjcm
9
0.3 2 hours
0.4
U C 12 hnurs (18:40 14:18:45 14:18:50 14:18:55 14:19:00 14:19:05 14:19:10 l4:i :15
2 Time
8o 8 24 hours
-0.6 48 hours
™NaET KO

You can also choose to display all of the data collected.

Fetching
Live data can come from one of two sources: streaming or fetching.

Fetching is the action of asking the instrument to take a reading and report it.

Click the Fetch button to start fetching data. The button will change to Pause u . Click the Pause button u
to stop fetching.
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14 Firmware updates

Ruskin automatically checks if your instrument firmware is up-to-date. Updates may be critical, routine, or customised.

14.1 Critical firmware updates

If a newer version is available and this update is critical, the Update firmware button and a warning message will
appear at the top of the Configuration tab.

Configuration Information | Calibration | Parameters

Firmware Update

Update firmware

Steps
1. Click Update firmware.
The Update logger firmware window will appear. It will contain Release notes, outlining the new version
number, its release date, improvements, and bug fixes associated with this release, and two standard buttons at
the bottom of the window: Close and Proceed.

Update logger firmware

Use this utility to update your logger.

Release notes

Attention: if your instrument currently has firmware version 1.138 or later, you are strongly advised to proceed with
this upgrade. It improves support for a variety of memory device types, ensuring that the full data capacity is
available for reliable data storage.

Version 1.141 - 05 May 2022
Requires Ruskin 2.18.0
Improvements
« Internal support for multiple memory device types (L3-932)
Bug fixes

+ Fixed parameter checking for Direction-Dependent sampling mode to prevent use of invalid periods (L3-
928)

Close Proceed

2. Click Proceed to initialise the update.
The instrument will disappear from the Navigator window during the upgrade. Watch the progress bar at the
bottom of the window for the status.

© Do notdisconnect the instrument until a confirmation message is displayed. Disconnecting during the
update process may render the instrument inoperable.
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If the upgrade does not complete successfully, go to the Instruments menu and launch the update dialogue.

@ Ruskin File Instruments Help

| RN Simulate an instrument...

1t Navigatof b Disconnect from instrument =

v i Instruments
CRBRconcerto®
i MLM
g Datasets Utilities >

Automatic tasks »

The Update logger firmware window will appear. Click Proceed again to retry.

If the instrument does not reappear in the Navigator window after a firmware update, disconnect your instrument from
the USB port and then reconnect to establish communication.

14.2 Routine firmware updates

If the latest update is not critical, Ruskin will not display any warning message. However, you can always check

manually if a newer firmware warning is available. Go to Instruments > Update instrument firmware. The Update
logger firmware dialog box will appear.

Update logger firmware
(L) Your instrument has the latest firmware available: 1.101
Select the instrument to upgrade

Instrument  RBRsolo® 209681 ]

Select the firmware image

Compact Logger (0) v1.110 Import...
Release notes

Version 1.110, 16-May-2013
New Feature release for RERsoloT
Requires Ruskin 1.8.0.

Improvements
+ More robust response to and recovery from power loss (LL-650).

+ Various bug fixes (LL-655, LL-603, LL-761)
= New platform compatibility (LL-595)

Close Proceed
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In addition to the new version number, its release date, improvements, and bug fixes, there will be two additional
sections: Select the instrument to update and Select the firmware image.

Steps
1. From the Instrument dropdown, select the instrument you wish to upgrade.

Select the ir ~

RBRsolo® 209609
Instrument  peRc6da’2096 68 |
+ RBRconcerto® 209681

Select the f

2. From the next dropdown, select the latest firmware image.

Select the firmware image

Compact Logger (0) v1.110 | Import..

Compact Logger (1) v1.120
Compact Logger (2) v1.140
Compact Logger (3) v1.000

Compact Logger (4) v1.000 s firmware version
Compact Logger (9) v1.000 ariety of memory de
Compact Logger (102) v3.290

Compact Logger (102) v3.010

3. Click Proceed to initialise the update.
The instrument will disappear from the Navigator window during the upgrade. Watch the progress bar at the
bottom of the window for the status.

© Do notdisconnect the instrument until a confirmation message is displayed.
Disconnecting during the update process may render the instrument inoperable.

If the upgrade does not complete successfully, click Proceed again to retry.

If the instrument does not reappear in the Navigator window after a firmware update, disconnect your instrument from
the USB port and then reconnect to re-establish communication.

14.3 Manual firmware updates

In certain cases, RBR may supply a customised firmware version, which will not be on the dropdown list.

Go to the Instruments menu and launch the update dialogue.
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@ Ruskin File Instruments Help

| RN Simulate an instrument...

1t Navigatof b Disconnect from instrument =

v i Instruments
CRBRconcerto®
i MLM
g Datasets Utilities >

Automatic tasks »

The Update logger firmware dialog box will appear. Follow the steps below to import the firmware image provided by
RBR and update your firmware.

Steps
1. Inthe Update logger firmware dialog box, click Import.

Select the firmware image

Compact Logger (0) v1.110 a Impaort...

2. Browse to the location of the firmware update file. The file will have the extension .rbrfw.
3. Select the file and click Open.
The file will appear on the dropdown list.

Select the firmware image

L3-1X142-5118.rbrfw 3 Import...

Release notes

Version 1X142 - 02 June 2022
Requires Ruskin 2.16.0

MNew Features

Bug Fixes

4. Click Proceed to initialise the update.

The instrument will disappear from the Navigator window during the upgrade. Watch the progress bar at the
bottom of the window for the status.

© Do notdisconnect the instrument until a confirmation message is displayed. Disconnecting during the
update process may render the instrument inoperable.
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15 Automatic tasks

When working with a large number of similar instruments, Ruskin offers various automatic tasks.

Access these options from the Instruments menu on the top toolbar.

kin  File Instruments Help

‘A

'@ o @ Simulate an instrument...

£ Nawgil Update instrument firmware...

= O “EICannectiﬂr
IEEEEE— |

v ' Ins
RBF + 28 Auto-download .
@sim it g Auto-stop
L ilities
isim Auto-deploy IH
@simRBReoda® 905954 E View auto-deploy settings ;
wiin MLM Gttt
v = Datasets || [dev/tty
ESlTalal=l=i] A0
Alternatively, right-click Instruments in the Navigator window.
=

45 Navigator

v ' |nstruments

Simulate an instrument...

' RBRconcerto?
min ML + Auto-download
g Datasets
Auto-stop
Auto-deploy

View auto-deploy settings...

When you enable a task, it will show a checkmark next to it, and the corresponding icon will be displayed in the

Navigator window.

Auto-stop  Auto-deploy

v ‘ Instruments

¥ %

N
Auto-download

Since these tasks can change the state of your instrument, their settings default to "off" each time Ruskin is run.
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Auto-download

When Ruskin detects an instrument, it will automatically start a download process. The downloaded dataset will be
named following the standard naming convention, and saved in the default directory. Other than possibly creating
unwanted files, this option is safe since it does not alter the state of the instrument.

Auto-stop

When Ruskin detects a previously enabled instrument, it will automatically stop the deployment. If auto-download is
not selected, it will also display a warning about downloading the instrument data.

& Allthe data on the instrument will be erased as soon as you enable a new deployment. RBR recommends
enabling the Auto-download feature whenever you enable Auto-stop.

Auto-deploy

When Ruskin detects an instrument, it will stop the deployment and then reprogram your instrument with the last
known configuration settings. Use this feature when you have several instruments with the same capabilities.

A Allthe data on the instrument will be erased as soon as you enable a new deployment. RBR recommends
enabling the Auto-download feature whenever you enable Auto-deploy.

To use this feature, follow these steps:

1. Connectto an instrument that will act as the model.
2. Configure this instrument with the desired settings.
3. Enable Auto-deploy as shown above.

Now, when you connect to an instrument with same capabilities as the model instrument, Ruskin will configure it to
match the the model schedule.

A Auto-deploy implies Auto-stop.
Ruskin must stop your instrument to change deployment parameters, so it will stop even when there is no
checkmark next to the Auto-stop task.
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View auto-deploy settings

To view the currently active auto-deploy parameters, go to Instruments > View auto-deploy settings... .

The Auto-deploy settings box will open, with saved parameters outlined.

Auto-deploy settings

Configuration of auto-deploy

Schedules

Clock sync: NOME

Start date: 2022-05-17 15:39:00
End date: 2099-12-30 19:00:00
Mode; CONTINUOUS

Sampling period: 2Hz

Parameters

Setting

ALTITUDE

ATMOSPHERE
AVERAGE_SPEED_DOF_SOUND
CAST_DETECTION
COMNDUCTIVITY

DENSITY

DISSOLVED_O2_GENERIC_UNIT
DISSOLVED_O2_OPTODE_UNIT
DISSOLVED_O2_OXYGUARD_UNIT
DISSOLVED_O2_RINKO_UNIT

Requirements

FASTCONTINUOUS

SIMPLIFIED_DEPTH_CALCULATION_TYPE

Auto-deploy settings

Valua
0.0000
9.7700000
1550.7440
on

42.914
1.0000000
on

mgfL
uMoliL
mg/L

mafL

Dismiss
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16 User calibration

Factory calibration coefficients are calculated for each sensor, and the coefficients are stored on the instrument.

RBR calibration certificates contain calibration equations, coefficients, and residuals for each sensor. Hard copies are
provided with each shipment. RBR can replace lost or misplaced calibration certificates upon request.

RBR recommends calibrating your instrument before any critical deployment, periodically once a year, or if you suspect
the readings to be out of specifications.

Discuss your calibration requirements with RBR. In some cases, the instrument will need to be returned to RBR to have
it checked and re-calibrated.

Please contact RBR for our current calibration fees.

View current calibration coefficients for your sensors under the Calibration tab in the Properties window.

Sensors such as the dissolved oxygen and turbidity can be field-calibrated. Update the calibration coefficients for these
channels periodically. On occasion, you may need to manually enter new coefficients, although this is not
recommended for factory-calibrated sensors (for example, T or D) unless instructed by RBR.

To calibrate a sensor, you need to let it sample in a known environment and then compare the result to the established
value. The difference will be used to generate calibration coefficients. With the N-point method, the known
environment is changed N times. The higher the N, the more accurate are calibration coefficients.

16.1 Dissolved oxygen sensor calibration

For dissolved oxygen sensors, RBR recommends user calibration using the N-point method, with N =2, which will
include a zero reference point and a non-zero reference point. It is, however, acceptable to perform a one-point
calibration.

16.1.1 DO data collection

Follow the steps below to obtain the calibration dataset for your dissolved oxygen sensor.
Equipment and materials

« Awide-mouth, black-walled container with a cover

« Asmall container or beaker

« Air pump (for example, an aquarium air pump with a stone bubbler)
« Magnetic stirrer

« Sodium sulphite Na,SO5

« Distilled water

Ruskin configuration

1. Goto Configuration.

Select UTC or Local, depending on your preferences, to synchronise the instrument clock with your computer.
Set the sampling rate at 1s (1Hz).

Enable your schedule.

HwnN

& Theinstrument must be logging throughout the calibration procedure.
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Non-zero reference point

1. Fillthe black-walled container with distilled water.
Install the magnetic stirrer.
Install the air pump.
Switch on both the air pump and the magnetic stirrer.
Leave them on overnight, or for at least 3-4 hours, to achieve saturation.
Submerge the dissolved oxygen sensor in the solution, going in at an angle and stirring to avoid bubble buildup
on the sensor window.
Leave some space between the sensor and the beaker walls.
7. Position the sensor near the stirrer but not directly in the bubbles.
The bubbler should be shallower than the sensor.

oukhwN

Cover

Bubbler

Dissolved
oxygen
sensor

Magnetic
stirrer

e

8. Record the data for at least 30 minutes.
This is the 100% oxygen concentration calibration point.

Zero reference point

A Omit this step when performing the one-point calibration.
If you calibrate your dissolved oxygen sensor using the one-point calibration method at 100% oxygen
concentration only, calibration should be performed at the expected temperature and salinity of the
deployment environment.

1. Inasmall container or beaker, prepare a 0.1% solution of sodium sulphite (0.25g of Na,SO3 for 250mL tap
water).

2. Mix the solution thoroughly with a magnetic stirrer. The solution will be oxygen-free after 15 minutes.

3. Submerge the dissolved oxygen sensor in the solution, going in at an angle and stirring to avoid bubble buildup
on the sensor window.
Leave some space between the sensor and the beaker walls.
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sensor &

Magnetic
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4. Record the data for at least 30 minutes.
This is the 0% oxygen concentration calibration point.

& This Na,S03 solution has a limited lifespan and should not be used for more than a day.

16.1.2 DO calibration in Analysis tab

For DO sensors, RBR recommends a two-point user calibration, which includes a zero reference point and a non-zero
reference point. It is, however, acceptable to use a one-point calibration.

Two-point calibration steps on Ruskin

1. Stop the deployment.
2. Download the dataset.
3. Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab

displayed.
@ Instruments Analysis . Overview | Channels | File info
ORBRconeerto? 209681 -
win MLM Cursor  Calibration
v & Datasets
[ 207701...-Cal e —
Time 2021-08-27 16:25:00.000-04:00

Display statistics

Number of samples

Channel Value Unit
Dissolved O; concentration 200.7831154 pmolfl

4. Click Calibration.

5. Select Dissolved O, saturation from the dropdown list.
By default, the Number of samples is set to 100, which means Ruskin will average the calibration coefficients
over a hundred sample points. Typically, this value should be in the range from 50 to 100 samples.
The Raw channel box is unchecked, and thus the true DO values will be displayed in the plot below. To see the
raw voltage values, check this box.
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Analysis . Overview | Channels |File info |
Cursor  Calibration

Dissolved O; saturation 8

Mumber of samples 100 o  linear (2]
Current coefficients

564.0000000 E-3 1.0721800

Avg Std Real Avg Residual

A downsampled representation of the dataset will appear in the thumbnail view, with two distinct plateaus
corresponding to 100% and 0%. Irregular readings in-between mark the times when you changed from distilled
water to sodium sulphite solution and reassembled the setup.

6. Click on astable pointin the Plot view corresponding to 100% oxygen.

FrNA- @ @ @y BEe

110.000

100,000

saturation (%)

Dissolved 0,
s
g

0433 09135 09137 09739 09341 094, 09345 09347 09249 08551 09’53
Time

09’55

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval
will appear in the table above.

7. Under Real Avg in the first row, enter 100.

Analvsis"- Overview | Channels | File info
Cursor  Calibration

Dissolved O saturation

Mumber of samples 100 o  linear

Current coefficients

-2.4827037 1.0752212
Avg Std Real Avg Residual
v 89.746015 0.0525042 100.000000
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8. Repeat the same steps for the second plateau, entering 0 under Real Avg.

9. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated coefficients.

Analysis Overview | Channels | File info
Cursor  Calibration

Dissolved O; saturation &

Number of samples 100 o  linear &

Current coefficients

-2.4827037 1.0752212
Mg Std Real Avg Residual
99.746015 0.0525042 100.000000 -98.7840262
0.142015 0.0219689 0.000000 3.2184301

Mew calibration coefficients have been calculated

Calculated coefficients

-2.6351535 1.0794960 oy

10. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
11. Inthe Navigator view, find your instrument.

12. Click Calibration and select Dissolved O, saturation from the dropdown list.

13. Click €0 to select the entry field and type in the new value (in this example, -2.6351535 ).
14. Click C1 to select the entry field and type in the new value (in this example, 1.0794960 ).

15. Click Store calibration to save the new coefficients.

A Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost
once your session is closed.
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One-point calibration steps on Ruskin

a

w N

No ok

®

10.
11.
12.
13.
14,

If you calibrate your dissolved oxygen sensor using the single-point calibration method at 100% oxygen
concentration only, calibration should be performed at the expected temperature and salinity of the
deployment environment.

Stop the deployment.

Download the dataset.

Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab
displayed.

Click Calibration.

Select Dissolved O, saturation from the dropdown list.

Check the 1 point calibration box.

Click on a stable point in the Plot view corresponding to 100% oxygen.

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval
will appear in the table above.

Click the RealAvg column and select 100 from the dropdown.

Click Copy to save the new calibration coefficients to the clipboard, or write them down.

In the Navigator view, find your instrument.

Click Calibration and select Dissolved O, saturation from the dropdown list.

Click €O to select the entry field and type in the new value.

Click €1 to select the entry field and type in the new value.

Click Store calibration to save the new coefficients.

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost
once your session is closed.

16.2 Turbidity sensor calibration

RBR compact instruments support turbidity sensors from Seapoint®.

RBR factory-calibrates the turbidity sensors using the N-point method, with N = 7. For user calibration, we recommend
using the two-point method (N = 2) under fluorescent lighting, which will include a zero reference point and a non-
zero reference point.

Alternatively, you can perform a one-point calibration using a single zero reference point in distilled water. Calibration
will only correct the coefficients for an offset.

®

When performing the one-point method, use only a zero reference point.
With a single non-zero reference point, calibration will recompute the slope coefficient. Go this route only if
you are confident in your non-zero standard.
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16.2.1 Tu data collection

Follow the steps below to obtain the calibration dataset for your Tu sensor.

Equipment and materials

« Awide-mouth, black-walled container (large enough to hold the instrument)

+ Secure black lid for the container with an orifice for the instrument

« Small black lid or any light-blocking material to cover the orifice during calibration
+ 400FTU Formazin standard

+ Distilled water

« Large magnetic stirrer

+ Rubbing alcohol

+ Soft cloth

Ruskin configuration

1. Go to Configuration.

Use Local on Ruskin to synchronise the instrument clock with your computer.
Set the sampling rate to 1s (1Hz).

Under Ranging sensors, set Range to Auto.

Enable your schedule.

akrwn

A Theinstrument must be logging throughout the calibration procedure.

Sensor preparation
1. Wash the sensor and container with distilled water and dry them with a soft cloth.

2. Check the turbidity window for stains and scratches.

& Do not proceed with calibration if there are serious scratches.

3. Wipe the turbidity window with alcohol to remove all stains.

Zero reference point

1. Fill the black-walled container with distilled water.

2. Turnon the magnetic stirrer and adjust the RPM to ensure no vortex appears.

3. Place the black lid on the container and avoid direct light on the container.

4. Submerge the sensor though the orifice in the lid, vertically along the wall, with the turbidity window facing the
larger water volume.

& Thedistance from the turbidity window to the container wall must be at least 20 cm.

5. Cover the orifice with the smaller black lid or light-blocking material, like a thick plastic bag.
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6. Record the data in distilled water for at least 15min, up to an hour.
This is the zero-turbidity calibration point.

Non-zero reference point
Repeat the steps for the zero reference point, replacing distilled water with 400FTU Formazin standard.

This is the 400NTU calibration point.

As each reference point takes 15 minutes to an hour, the entire procedure may take up to two hours.

After completing the procedure for both reference points (or for a single reference point, if using the one-point method),
proceed to calibration on Ruskin.

16.2.2 Tu calibration in Analysis tab
For turbidity calibration, we recommend using the two-point method, which includes a zero reference point and a
non-zero reference point.

Alternatively, you can perform a one-point calibration using a single zero reference point.

Two-point calibration steps on Ruskin

1. Stop the deployment.

2. Download the dataset.

3. Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab
displayed.
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Analysis Owerview | Channels | File info

Cursor  Calibration

Sample 1401 - 1500
Time 2022-05-27 15:46:47.000Z - 2022-05-27 15:51:44.0002

Display statistics

Mumber of samples 100 T

Channel Value Avg Std Unit
Temperature 21.6900802 21.6917967 0.0006431 °C
Turbidity 327.2716984 328.4828327 0.7709818 NTU

4. Click Calibration.

5. Select Turbidity from the dropdown list.
By default, the Number of samples is set to 100, which means Ruskin will average the calibration coefficients
over a hundred sample points. Typically, this value should be in the range from 50 to 100 samples.
The Raw channel box is unchecked, and thus the true turbidity values will be displayed in the plot below. To see
the raw voltage values, check this box.

Analysis . Owverview | Channels | File info
Cursor  Calibration

Turbidity ] Raw channel 1 point Calibration

Number of samples 100 5  linear (2]
Current coefficients

3.0639380E3 -4.1818820 E3

g Std Real Avg Residual

A downsampled representation of the dataset will appear in the thumbnail view, with two distinct plateaus
corresponding to ONTU and 400NTU. Irregular readings in-between mark the times when you changed from
water to formazin and reassembled the setup.

6. Check the box next to the first row in the calibration table.
7. Click on astable pointin the Plot view corresponding to zero NTU.

=

2l

550.000

500.000

450.000

4D0.000

350.000

300.000

250.000

200.000

Turbidity (NTU)

150.000

160.000

50.000

(]

-50.000

13:38 13:40 13:42 13:44 13:46 13:48 13:50 13:52 13:54

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval
will appear in the table above.
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8. Under Real Avg in the first row, enter 0 and press enter.

Analysis' Overview | Channels | File info

Cursor  Calibration

Turbidity [Z] Raw channel 1 point Calibration

-~

Number of samples 100 5  linear %)
Current coefficients

3.0639380E3 -4,1818820 E3

g Std Real Avg Residual
0.005194 0.0091773 0.000000

Repeat the same steps for the second plateau, entering 400 under Real Avg.
9. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated coefficients.

Analysis Overview | Channels | File info

Cursor  Calibration

Turbidity ] Raw channel 1 point Calibration

Number of samples 100 5  linear [Z]
Current coefficients

3.0639380E3  -4.18188B20E3

Ayg Std Real Avg Residual
0.002736 0.0021226 0.000000 0.0000000
v 350.899191 1.1599181 400.000000 0.0000000

New calibration coefficients have been calculated

Calculated coefficients

3.4926945E3  -4.7670838 E3 Gopy

& When atwo-point calibration is performed correctly, residuals will be 0.

10. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
11. Inthe Navigator view, find your instrument.

12. Click Calibration and select Turbidity from the dropdown list.

13. Click €0 to select the entry field and type in the new value (in this example, 3492.6945 ).
14, Click €1 to select the entry field and type in the new value (in this example, -4767.0838).
15. Click Store calibration to save the new coefficients.

A Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost
once your session is closed.
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One-point calibration steps on Ruskin

1. Stop the deployment.

Download the dataset.

Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab
displayed.

Click Calibration.

Select Turbidity from the dropdown list.

Check the 1 point calibration box.

Click on a stable point in the Plot view corresponding to ONSU.

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval
will appear in the table above.

8. Click the RealAvg column and select 0 from the dropdown.

w N

No ok

Analysis Overview | Channels | File info

Cursor  Calibration

Turbidity & Raw channel « 1 point Calibration

Number of samples 100
Current coefficients
3.2494240 E3 -4.4350240 E3

Avg Std Real Avg Residual
v 1.148650 0.0147817 0 ¥ 0.0000000

100 .

Mew calibration coefficients have been calculated

Calculated coefficients

3.2860202E3  -4.4865589 E3 Copy

9. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
10. Inthe Navigator view, find your instrument.
11. Click Calibration and select Turbidity from the dropdown list.
12. Click €0 to select the entry field and type in the new value.
13. Click €1 to select the entry field and type in the new value.
14. Click Store calibration to save the new coefficients.

A Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost
once your session is closed.
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Revision No.

1.0-H
J

RBR#0006106revK

Release Date

2011-2020
31-August-2022

31-December-2022

Notes

Various

Restructured the user guide to reflect Ruskin interface, added a

dedicated page for RSK files, edited existing instructions for
clarity, removed outdated sections and screenshots

Added a section on the Search option under Support (for Mac
users). Updated the RSK files and File info sections to reflect
new file structure labels. Enhanced Plot window instructions.
Updated the Power section. Corrected typos in the User
calibration section.
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